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Preface 

The Test Programming Supporter TPS-4 (hereinafter called “TPS software”) is off-line programming software for the 
Takaya Fixtureless tester APT-9411 Series to assist users in programming test data on the workstation. 

Please read this manual thoroughly before using this option. Then keep this manual handy for answers to any questions 
you may have. 

If you have any questions or thoughts you would like to share with us –  we would like to hear from you. 

 
 
 
 
(NOTE) 

1)  The design of the product and software are under constant review and while every effort is made to keep this 
manual up to date, we reserve the rights to change specifications and equipment at any time without prior notice. 

2)  Windows® , Windows®NT is a registered trademark of Microsoft Corporation. Also the company name and the 
product name listed in this User’s guide are the trademark of each company. 

3)  No portion of the contents of this publication may be reproduced or transmitted in any form or by any means without 
the express written permission of TAKAYA CORP. 

 
 

Safety symbols 

Symbol Explanation 

 

Calls attention to general instruction. 
Failing to follow this could loss of data stored on disks causes possibly misjudge the unit 
under test, or damage to the product. 

 

Calls attention to “One-point advice” which should be useful when you are at a loss to operate 
the products. 
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Prior consent 
IF YOU DO NOT AGREE TO ALL TERMS DESCRIBED BELOW, DO NOT USE THIS PRODUCT. 
 
1. Takaya, as Licensor, grants to you, the Licensee, a nonexclusive right to use this software. 
 
2. Takaya retains the copyright, title and ownership of the software and written materials regardless of the form or 

media in or on which the original and other copies may exists. 
 
3. You are not permitted to rent, lease, sub-license, loan, copy, modify, adapt, merge, translate, reverse-engineer, 

decompile, disassemble or create derivative works based on the whole or any part of the software or its related 
documentation. 

 
4. This software is provided to you strictly "as is", without warranty of any kind, either express or implied, including, but 

not limited to, the implied warranties of merchantability and fitness for a particular purpose. 
 
5. Takaya and/or its respective suppliers shall not be liable for any direct, indirect, consequential or incidental damages 

(including damages for loss of business profits, business interruption, loss of business information, and the like) 
arising out of the use or inability to use the product even if Takaya and/or its respective suppliers has been advised of 
the possibility of such damages. 
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General Outline 
This Operator’s guide explains the TPS software with a focus on two ways of data programming method below. 
 
1. Digitizer function based data programming (Refer to Page 9) 

The TPS software allows users to input XY coordinates and establish the High-fly / No-contact zone while looking at 
the board image on the display, after imported a mount data processed into a specified format (ex. “Parts (name), 
“Value” and “Center coordinates of components” so on) and the image file made by the Real map function. 

 
2. Auto data conversion based on Parts library (Refer to Page 39) 

The TPS software has its own idiosyncratic function to convert a mount data processed into a specified format to into 
a test program automatically based on a library information (so-called “Parts Code Database”) owned by the TPS 
software. 

 

 

The TPS-4 software shares lot of function with the APT software. So they are beyond the scope of this 
Operator’s guide. See the APT manuals for details. 

 
 

Hardware requirements 

PC : PC/AT compatible PC 
CPU : 2GHz or more 
Memory : 512MB or more 
OS : Windows XP (No other operating system can support) 
HDD : Approx. 40GB or more of disk space 
 
 

System configuration files 

DataConvert.db : Parts Code Database 
Convert.mdt : Configuration file (automatically generated during the first startup) 
MASTER.mdt : Master mode’s configuration file (automatically generated during the first startup) 
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System Installation 
This chapter describes a new installation and update procedures of the TPS software. 

< New installation procedure of the TPS software > 

1 Insert ‘TPS-4 Install CD’ in the CD-ROM drive. 

2 The installer starts up automatically.  
 
Click “Next >” button on Begin to Install window. 

 
3 The display changes to Software License Agreement 

window.  
 
Use your mouse to highlight “ACCEPT” button and 
click “Next >” button, if you were competent to consent 
to the software license agreement. 

 
4 The display changes to Save User Information 

window.  
Type in “User Name” box and “Organization” box 
before you click “Next >” button. 

 
5 The display changes to Choose Destination Location 

window.  
Verify the directory where the TPS software should be 
installed and click “Next >” button. 
 
NOTICE)  
Please do not modify it unless there is some particular 
reason. 
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6 The display changes to Ready to Install window.  
Double-check your entry on the display and click 
“Install” button. Then the installation begins to start 
automatically. 
 
NOTICE)  
Click “< Back” button if you want to change any of your 
installation setting. 

 
7 After the TPS software installation was completed, the 

display changes to Completing TPS-4 Installation 
Wizard window. 
Click “Finish” button to close the window. 

 
8 Installation Wizard window will now terminate and then 

automatically create a shortcut “TPS-4” icon on the 
desktop. 
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< Update procedure of the TPS software > 

1 Insert ‘TPS-4 Install CD’ in the CD-ROM drive. 

2 The installer starts up automatically.  
 
Choose “Only update tools for TPS4 systems” and 
then click “Next >” Button on Begin to Install window. 

 
3 The display changes to Choose Destination Location 

window.  
 
Verify the directory where the TPS software should 
be installed and click “Next >” button. 
 
NOTICE)  
Please do not modify it when you update the system. 

 
4 The display changes to Ready to Install window.  

 
Click “Install” button and then the installation begins to 
start automatically. 
 
NOTICE)  
Here users can not revise User Information. 
Please reinstall the software if necessary to revise it. 

 
5 After the TPS software installation was completed, 

the display changes to Completing TPS-4 Installation 
Wizard window. 
Click “Finish” button to close the window. 
 
Installation Wizard window will now terminate to finish 
the TPS software update. 
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Starting and Quitting TPS software 
This chapter explains the way of start and quit the TPS software. 
 
 
■  Starting the TPS software 

1. Turn on the PC to start the Windows® . 

2. Double click an icon [  ] on the desk top with the mouse, and the TPS software starts automatically. 
 
■  Quitting the TPS software (1) 

Click Close button [  ] at the right-top corner of the Application window. 
 
■  Quitting the TPS software (2) 

Select File on Menu bar and click Close from the menu. 
 
■  Quitting the TPS software (3) 

Press [Alt] key and [F4] key on the keyboard simultaneously. 
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Application Window 
This chapter explains the application window of the TPS software. 

 
[Fig.1] Application window 

 
Window buttons 
At the right side of Title bar there are the Window buttons. 

Minimize Maximize Restore Close 

    

Reduce the window to 
an icon 

Enlarge the window to fill 
the screen 

Return the window to its 
last non-minimized, 

non-maximized position 
Close the window 

 
Menu bar 

 
Menu bar contains the TPS software menus. Each menu lists a “family” of selections, and each selection performs a 
specific action. When a test program is listed on the display (Workspace), Menu bar changes as follow: 

 
 
 
Status bar 
Status bar is shown at the bottom of the Main window. Status bar displays the information about line, input mode and so 
on when it displays Step Edit list. (Refer to Fig. 2) 

 
[Fig. 2] Status bar 

Menu bar Minimize and Maximize buttons 

Close button 

Status bar 



- 9 - 

Digitizer function based data programming 
This chapter describes the digitizer function based data programming method under the assumption that the pin 
coordinates are assigned to each component’s land (=Teaching system). 

Programming flowchart  
 

Data process in Takaya format data (Refer to Page 10) 
 

Environmental Setting (Refer to Page 15) 
 

Data Conversion procedure (Refer to Page 20) 
 

XY Coordinates Input (Refer to Page 29) 
 

High-fly / No-contact-zone setting (Refer to Page 37) 
 

Optimization (Refer to Page 38) 
 

Data mode setting (Refer to Page 38) 
 

Test mode setting (Refer to Page 38) 
 

Data save (Refer to Page 38) 
 

Completion of test data programming by TPS software  
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Data process in Takaya format data 

User should process data file from the Pick/Place Machine (hereinafter called “mount data”) into specified text data format 
(hereinafter called “Takaya format data”) prior to import in the TPS software. 
 
The Takaya format data should consist of Parts, Value, XY Coordinates, SMD/THT and Mounting side. But when the 
mount data is separated in two different files for the top side (A-side) and the bottom side (B-side), Parts, Value, XY 
Coordinates and SMD/THT are enough. (The information on Mounting side is unnecessary) 
 
Users can select the appropriate delimiter from Comma, Space, Semicolon or Tab. The delimiter is one example among 
many and the Takaya format data is configurable in the Environmental setting window that is described later. 
 
 
Takaya format data 
List-1 indicates a sample data of when the mount data for the A-side and the B-side is saved in one file. 

Mark1 * 0 0 SMD TOP 
Mark2 * 93.98 104.0603 SMD TOP 
JP1 * 83.7899 -16.5499 THT TOP 
CN4 * 116.8099 15.2601 THT TOP 
R46 No-in 86.0759 74.8901 SMD TOP 
R45 330O 86.0759 79.9701 SMD TOP 
R7 No-in 78.7099 79.7161 SMD TOP 
IC6 * 57.1199 96.4801 SMD TOP 
IC16 * 88.2349 97.1151 SMD BTM 
C10 330nF 45.6899 -14.8989 SMD BTM 
      
Parts Value X-coor Y-coor SMD/THT Mounting side 

[List-1] Sample data 
 
Parts 
This is name of component or UUT (ex. R1,R2… ,IC101,IC102). (English one byte characters, max 11 letters) 
 
Value 
This is value of component. (English one byte characters, max 11 letters) When there is no information included in the 
mount data, use the keyboard to enter it manually in reference to List-2 below. 

Resistor Unit must be specified by “Ω ”. (Use “O” key of the alphabet) ex. 47O , 2.2KO, 1MO 

Capacitor 
Unit must be specified by “F”. ex. 22pF, 10nF, 47uF 
The Value of less than 1uF can be specified by color code. 
ex. 100pF →  101, 1000pF →  102, 10nF →  103, 0.1uF  →  104 

Inductor Unit must be specified by “H”. ex. 10uH, 2.2mH 

No placement Specify “No-in”, and the Function of Measuring condition is substituted by “JP” automatically. 

Others Specify asterisk (*) for the components that require nothing in the Value. 

[List-2] Rule of specifying Value 
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X-coor / Y-coor 
This is XY coordinates of each loaded components. The unit is assignable to mm, 100um, 10um, um or Inch in Convert > 
Environmental setting > Property > Unit of Coordinate. When the mount data uses other than above unit, convert it to any 
of mm, 100um, 10um, um or Inch, 
 
When the A-side isn’t separated from the B-side (means one file), the XY coordinates of SMD components at the B-side 
must be described with the XY coordinates viewed (see through) from the A-side. In addition, users should specify the 
Board reference point for both the A-side and the B-side to be the same point, in view of the A-side. 
 
SMD/THT (Surface-mounted components / Components inserted in the through holes) 
This is information on the state of each loaded components. (max 8 letters) Users should specify either SMD or THT. The 
letter strings of THT is assignable within 3 types (Ex. “DIP”, “THT”) at Convert > Environmental setting > Property > 
Identification code (THT). Other than these three letter strings assigned here is judged to manage as SMD. 
 
Mounting side 
This is information on Mounting side (A-side or B-side). (max. 8 letters) The letter strings of B-side is assignable within 3 
types (Ex. “B”, “BTM”) at Convert > Environmental setting > Property > Identification code (B-side). Other than these 
three letter strings assigned here is judged to manage as TOP. 
 
When the A-side and the B-side are managed in different files, the information on Mounting side is unnecessary. 
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Sample data of A-side and B-side which are managed in the same file 
When the A-side and the B-side are managed in the same file, it requires Parts, Value, XY Coordinates, SMD/THT and 
Mounting side as shown on List-3 below. 

Mark1 * 0 0 SMD TOP 
Mark2 * 93.98 104.0603 SMD TOP 
Mark1 * 10 10 SMD BTM 
Mark2 * 100 100 SMD BTM 
JP1 * 83.7899 -16.5499 THT TOP 
CN5 * 116.8099 -0.0199 THT TOP 
CN4 * 116.8099 15.2601 THT TOP 
R46 No-in 86.0759 74.8901 SMD TOP 
R45 330O 86.0759 79.9701 SMD TOP 
R8 No-in 71.0899 79.7161 SMD TOP 
R7 No-in 78.7099 79.7161 SMD TOP 
IC6 * 57.1199 96.4801 SMD TOP 
IC16 * 88.2349 97.1151 SMD BTM 
C10 330nF 45.6899 -14.8989 SMD BTM 
      
Parts Value X-coor Y-coor SMD/THT Mounting side 

[List-3] A-side and B-side are in the same file 
 
As mentioned, the XY coordinates of SMD at the B-side must be described with the XY coordinates viewed (see through) 
from the A-side. In addition, users should specify the Board reference point for both the A-side and the B-side to be the 
same point, in view of the A-side. 

YY
X

Parts(A-side) Parts(B-side)

A-side
BRP(A/B-side)  

[Fig.1] A-side and B-side are in the same file 
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Sample data of A-side and B-side which are managed in different files 
When the A-side and the B-side are managed in different files, it requires Parts, Value, XY Coordinates and SMD/THT 
as shown on List-4, 5 below. 

Mark1 * 0 0 SMD 

Mark2 * 93.98 104.0603 SMD 

JP1 * 83.7899 -16.5499 THT 

CN5 * 116.8099 -0.0199 THT 

CN4 * 116.8099 15.2601 THT 

R46 No-in 86.0759 74.8901 SMD 

R45 330O 86.0759 79.9701 SMD 

R8 No-in 71.0899 79.7161 SMD 

R7 No-in 78.7099 79.7161 SMD 

IC6 * 57.1199 96.4801 SMD 

     

Parts Value X-coor Y-coor SMD/THT 

[List-4] Sample data of A-side 
 

Mark1 * 10 10 SMD 

Mark2 * 100 100 SMD 

IC16 * 88.2349 97.1151 SMD 

C10 330nF 45.6899 14.8989 SMD 

R1 10KO 40.0120 35.10505 SMD 

R2 2.2KO 55.1965 12.56894 SMD 

     

Parts Value X-coor Y-coor SMD/THT 

[List-5] Sample data of B-side 
 
The XY coordinates of the A-side is based on the Board reference point on the A-side. 
The XY coordinates of the B-side is based on the Board reference point on the B-side. 
Users don’t have to specify the XY coordinates of the A-side and the B-side to the same point which is viewed (see 
through) from the A-side. 

B-side(Turn over in X-direction)

YY
X

Y Y

X

A-side
BRP(B-side)BRP(A-side)  

[Fig.2] A-side and B-side are in different files 
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Board reference point and Aux reference point 
Neither the edge nor the hole of the board is suitable for the Board reference point and the Aux. reference point used in 
the test program. If there are fiducial marks on the board, give this priority. In addition, if there is known offset value 
between the origin point and the fiducial marks in the mount data, the fiducial mark could be the Board reference point 
after the data conversion. 
 
Board reference point 
Users should register appropriate identification code (ex. Mark1) at “Identification code (Reference)” (Convert > 
Environmental setting > Property) in advance, in order to make it possible to recognize the fiducial mark and assign to the 
Board reference point automatically. If more than one step contains the Identification code (Reference), the TPS software 
is designed to convert the fiducial mark at the step which is the most closest to the top step to the Board reference point. 

 

When the A-side and the B-side are managed in the same file, users should specify the fiducial marks 
separately for the A-side and the B-side. Therefore, the Mounting side in the Takaya format data must 
be specified by the letter strings registered in “Identification code (B-side)” (Convert > Environmental 
setting > Property) in advance, in order to identify which fiducial mark it is. 

 
Aux reference point 1 
Users should specify Aux reference point 1 if they want to use the Coordinate amend function to correct possible 
inclination of the board. Aux reference point 1 should be specified to the fiducial mark which is as diagonally far as 
possible from the Board reference point. 
 
Users should register appropriate identification code (ex. Mark2) at “Identification code (Aux-1)” (Convert > Environmental 
setting > Property) in advance, in order to make it possible to recognize the fiducial mark and assign to the Aux reference 
point automatically. If more than one step contains the letter strings registered in the Identification code (Aux-1), the TPS 
software is designed to convert the fiducial mark at the step which is the most closest to the top step to the Aux reference 
point 1. 
 
Aux reference point 2 
In addition to Aux reference point 1, users should specify Aux reference point 2 if they want to use the Coordinate amend 
function to correct possible inclination and scale of the board. Aux reference point 2 should be specified to the fiducial 
mark which forms a triangular shape by Board reference point and Aux reference point 1. 
 
Users should register appropriate identification code (ex. Mark3) at “Identification code (Aux-2)” (Convert > Environmental 
setting > Property) in advance, in order to make it possible to recognize the fiducial mark and assign to the Aux reference 
point automatically. If more than one step contains the letter strings registered in the Identification code (Aux-2), the TPS 
software is designed to convert the fiducial mark at the step which is the most closest to the top step to the Aux reference 
point 2. 

 

When the A-side and the B-side are managed in the same file, users should specify the fiducial marks 
separately for the A-side and the B-side. Therefore, the Mounting side in the Takaya format data must 
be specified by the letter strings registered in “Identification code (B-side)” (Convert > Environmental 
setting > Property) in advance, in order to identify which fiducial mark it is. 
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Environmental Setting 

Click Environmental Setting in Convert menu to specify the Direction to convert B-side data so on. In addition, the 
Property window allows users to configure Takaya format data and select unit of coordinates from mm, 100um, 10um, 
um or Inch. 

 

1. The Environmental Setting window is configurable also when Takaya format data is imported. 
2. The changes in the Environmental Setting window is saved in the folder named “Projectdata” 

(hereinafter called “Projetdata folder”. Users can save different Environmental Settings in plural 
Project folders. 

3. Users can specify the Projectdata folder each time Takaya format data is imported.  
(Refer to Projectdata folder in Page 27) 

 
Click Environmental Setting in Convert menu to open the Environmental Setting window (Fig.4). 

 
[Fig.3] Environmental Setting in Convert menu 

 

 
[Fig.4] Environmental Setting window 

 
Direction to convert B-side data 
<< When users import Takaya format data which the A-side and the B-side are managed in the different files >> 
To test the THT components at A-side, users should change them to B-side. They can specify the invert direction to 
either X-direction or Y-direction. 

<< When users import Takaya format data which the A-side and the B-side are managed in the same file >> 
Users should specify the invert direction of B-side data to either X-direction or Y-direction. 

基 板 原 点

基 板 原 点

基 板 原 点

Turn over in X-direction

Turn over in Y-direction

A-side B-side

B-side

BRP

BRP

BRP

 

[Fig.5] 
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Offset value for normal test (off) 
The Takaya format data is converted for normal test, so that the contact points are generated properly with the specified 
offset from both edges of each component. Users can register the offset value between 0.000 mm and 9.999 mm as 
default in advance. 
 
Device set by parts name 
The function “EL” on the Parts Code Database is automatically set during the data conversion according to the capital 
letters registered on this window. 

 
[Fig.6] Device set by parts name 

 
Set Block copy items 
This allows users to specify the target items to be copied by executing “Implement block copy” on Edit menu in the Parts 
Code Database list. Check the box of the items if they should be copied. 

 
[Fig.7] Set Block copy items 
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Property 
This window allows users to configure various environmental settings. For other parameters than described here, refer to 
Page 48. 

 
[Fig.8] Property window 

 
Items / Read Items 
Users can configure the Takaya format data by selecting the items necessary to import (Parts, Value, XY coordinates, 
SMD/THT, Mounting side etc) and the sequence as they want. Clicking [ < ] or [ > ] button is able to move the selected 
items to another side. (Click [ << ] or [ >> ] button only when all the items have to move to another side at one time) In 
addition, Clicking [Up] or [Down] button are able to change the sequence of the selected items in the Read Items box. 

 
[Fig.9] Items / Read Items 

 

When “Read Items” was not configured exactly as per the Takaya format data to import, the data won’t 
be converted properly or some warning error would appear during the data conversion. 
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Select separator 
Choose the appropriate separator from the right pull-down menu. 

 

 

If this was set wrong, the data won’t be converted properly or some warning error would appear during 
the data conversion. 

 
Unit of Coordinates 
Choose the appropriate unit of coordinates from the right pull-down menu. 

 

 

If this was set wrong, neither the camera nor the probes would move to the correct location or some 
warning error would appear during the data conversion. 

 
Identification code (THT) 
Users can register maximum 3 kinds of identification codes (letter strings) for THT components described in “SMD/THT” 
of the Takaya format data. 

 
[Fig.10] Identification code (THT) 

 

If this was set wrong, it would misjudge the SMD/THT components or some warning error would appear 
during the data conversion. 

 
Identification code (B-side) 
Users can register maximum 3 kinds of identification codes (letter strings) for B-side components described in “Mounting 
side” of the Takaya format data. 

 

[Fig.11] Identification code (B-side) 

 

If this was set wrong, it would misjudge the Mounting side or some warning error would appear during 
the data conversion. 

 
Identification code (Reference) 
Users can register maximum 3 kinds of letter strings so that the Board reference point moves to the point assigned at any 
of these steps when the Takaya format data is loaded. If more than one step contains the Identification code (Reference), 
the Board reference point moves to the point at the step which is the most closest to the top step. 

 

[Fig.12] Identification code (Reference) 
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If this was set wrong, the Board reference point won’t be set correctly or some warning error would 
appear during the data conversion. 

Identification code (Aux-1) 
Users can register maximum 3 kinds of letter strings so that the Aux reference point 1 moves to the point assigned at any 
of these steps when the Takaya format data is loaded. If more than one step contains the Identification code (Aux-1), the 
Aux reference point 1 moves to the point at the step which is the most closest to the top step. 

 

[Fig.13] Identification code (Aux-1) 

 

If this was set wrong, the Aux reference point 1 won’t be set correctly or some warning error would 
appear during the data conversion. 

 
Identification code (Aux-2) 
Users can register maximum 3 kinds of letter strings so that the Aux reference point 2 moves to the point assigned at any 
of these steps when the Takaya format data is loaded. If more than one step contains the Identification code (Aux-2), the 
Aux reference point 2 moves to the point at the step which is the most closest to the top step. 

 

[Fig.14] Identification code (Aux-2) 

 

If this was set wrong, the Aux reference point 2 won’t be set correctly or some warning error would 
appear during the data conversion. 

 
Separate file for A-side and B-side 
Users should check the box only when loading the Takaya format data which is separated in two different files for the 
A-side and the B-side. In this case, the Load Data (Takaya format) File in Convert menu asks users to load the Takaya 
format data separately for the A-side and the B-side as shown in the left window of Fig.15. 
Users should not check the box when loading the Takaya format data where the A-side and the B-side are managed in 
the same file. In this case, the Load Data (Takaya format) File in Convert menu is the right window in Fig.15. 

  
Separate files for A/B-side                               Same file for A/B-side 

[Fig.15] 
 
Correct distortion of the image prior to loading the JPG/BMP file 
Users should check the box only when the digitizer function based programming data uses image data scanned in a 
scanner and taken by a digital camera. (But this box should not be checked when they use image data taken by Real 
map function available as option for the APT-9411 Series.) 

 

1. In some image data, users cannot correct the distortion correctly. From time to time, the images 
taken by a digital camera is not so suitable to the TPS-4 because they are much curved at the top 
and the bottom and the ratio of expansion and contraction is nonconstant. 

2. As for the images scanned in a scanner, choose the one which has constant ratio of expansion and 
contraction. 
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About image file 
The TPS software is capable of loading image data (IMG file) taken by Real map function available as option for the 
APT-9411 Series or image data (BMP, JPG file) scanned in a scanner and taken by a digital camera. 

 

1. The image file must be saved in the same folder as the Takaya format data is. 
2. The TPS software is unable to load other than the image files with extension of IMG, BMP and JPG. 
3. In some images scanned in a scanner, they are ill-suited to the Digitizer function based programming 

data as the picture is unclear depending on the scanning condition so on. 
 

 

Users are recommended to use image data taken by Real map function available as option for the 
APT-9411 Series as the picture is clear and has less distortion. 

 

Data Conversion procedure 
Listed below is the procedure to convert the Takaya format data and the image data (.IMG file taken by Real map 
function) into the test program for the APT-9411 Series. 
 
Operation procedure 
(1) Choose “Load Data (TAKAYA format) File” from Convert menu. (Refer to Fig.16) 

 
[Fig.16] Load Data (TAKAYA format) File 

(2) The TPS software opens the Select Environmental Setting window. (Refer to Fig.17) Choose the appropriate 
Projectdata folder from the list. In addition users can create new Projectdata folders referring to “Projectdata folder” in 
Page 27. 

 
[Fig.17] Select Environmental Setting 

 

Right after Load Data (TAKAYA format) File was selected from Convert menu, the Data Conversion 
window (Fig.18) appears without displaying the Select Environmental Setting window unless the box 
“Maintain more than one environmental setting for convert” on File/Folder menu in Master mode is 
selected. 
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(3) The TPS software opens Data Conversion window. 

 
[Fig.18] Data Conversion 

Select Data (Text/CSV) File > Data File Name (A-side) 
Click the right browser button to select the file for A-side (Top side) from the specified folder. 

Select Data (Text/CSV) File >Data File Name (B-side) 
Click the right browser button to select the file for B-side (Bottom side) from the specified folder. 

Select Image (IMG / BMP / JPG) File > Image File Name (A-side) / (B-side) 
Click the right browser button to select the image data file for A-side / B-side from the specified folder. 

Distance between origins at A-side and B-side 
Users should specify the exact distance between two origin points on A-side and B-side of the Takaya format data. 
This could be the offset value to have the probes contact the THT components available on A-side from B-side. 

A-side

THT(A-side)

SMD(B-side)

X-distance

BRP(A-side) BRP(B-side)  
[Fig.19] Distance between origins at A-side and B-side 

 

1. “Distance between origins at A-side and B-side” is displayed only when the Takaya format data is 
managed in two separate files for Side-A and Side-B. 

2. When the Takaya format data is managed in the same file for Side-A and Side-B, it displays Fig.20. 

 
[Fig.20] Data File Name 
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(4) After the Data Conversion window was configured properly, click the Execute button to load the Takaya format data 
and the image files at the same time. 

 
(5) The TPS software takes some time to convert the Takaya format data and it displays Real Map Adjustment window 

(Fig.21) where users can fit the PCB image of A-side to the transmissive PCB image of B-side. 

 
[Fig.21] Real Map Adjustment 

 

The TPS software assumes the PCB image of B-side that was reversed in “Y-direction”. If the TPS 
software loads the PCB image of B-side which was reversed in X-direction, users cannot work out this 
operation until the PCB image of B-side is revised to the correct direction. Be sure to select “X-Reverse 
Turn” on the bottom of the window if the PCB image of B-side was captured after they reversed the PCB 
in X-direction. 

 
[Fig.22] 

 
(6) Use the arrow keys on Fig.21 to fit the PCB image of A-side to the transmissive PCB image of B-side and click the OK 

button. 

 
[Fig.23] Fit the PCB images for A-side and B-side 
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(7) It displays Board reference point set window (Fig.24). Set the cross-hair pointer on the Board reference point and click 
the Next button. 

 
[Fig.24] Board reference point set 

(8) It displays Aux reference point set window (Fig.25). Set the cross-hair pointer on the Aux reference point and click the 
Next button. 

 
[Fig.25] Aux reference point set 

(9) When there is data of B-side, it displays another window (Fig.26) where users should configure the Board reference 
point and the Aux reference point. Configure them in the same manner and click the Next button. 

 

[Fig.26] Configure B-side 

(10) It displays Data Conversion window (Fig.27). Click the Close button to finish the data conversion. 

 
[Fig.27] Data Conversion (IMG file) 
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Loading of BMP, JPG file 
The data conversion procedure varies a little according to the image file. Listed below is the procedure that users should 
follow when they use .BMP and .JPG files instead of the .IMG file. 
 
Operating procedure 
(1) After clicked the Execute button on Fig.18 in Page 21, it displays the next window (Fig.28) where users can remove 

distortion from the PCB image (A-side). 

 
[Fig.28] Remove distortion (A-side) 

 
(2) Set the cross-hair pointer on the four corners of the PCB image and click the Next button. (Refer to Fig.29) 

 
[Fig.29] Remove distortion (A-side) 

 
(3) It displays Board reference point set window (Fig.30). Set the cross-hair pointer on the Board reference point and click 

the Next button. 
Magnification bar facilitates the setting of the Board reference point as it can enlarge the image. (Refer to fig.31) 

    
          [Fig.30] Board reference point set                [Fig.31] Board reference point set (enlarged) 
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(4) It displays Aux reference point set window (Fig.32, 33). Set the cross-hair pointer on the Aux reference point and click 
the Next button. 

    
[Fig.32] Aux reference point set                      [Fig.33] Aux reference point set 

 
(5) It displays the next window (Fig.34) where users can remove distortion from the PCB image (B-side). Set the red 

frame on the right and the vertical lines of the PCB image and click the Next button. (Refer to Fig.35) 

    
[Fig.34] Remove distortion (B-side)                    [Fig.35] Remove distortion (B-side) 

 
(6) It displays Board reference point set window (Fig.36). Set the cross-hair pointer on the Board reference point and click 

the Next button. 

 
[Fig.36] Board reference point set (B-side) 
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(7) It displays Aux reference point set window (Fig.37). Set the cross-hair pointer on the Aux reference point and click the 
Next button. 

 
[Fig.37] Aux reference point set (B-side) 

 
(8) It displays Real Map Adjustment window (Fig.38) where users can fit the PCB image of A-side to the transmissive 

PCB image of B-side. 

 
[Fig.38] Real Map Adjustment 

 
(9) It displays Data Conversion window (Fig.39). Click the Close button to finish the data conversion. 

 
[Fig.39] Data Conversion (BMP/JPG file) 
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Projectdata folder 
The contents of the environmental setting (Fig.40, 41) are saved in a Projectdata folder together with the Takaya format 
data. When there are two or more environmental settings for the Takaya format data, users should specify the 
Projectdata folder prior to loading the Takaya format data. 

 

(1) Users should select the box “Maintain more than one environmental setting for convert” on the 
File/Folder window in Master mode if they want to manage the environmental settings separately by 
two or more Projectdata folders. 

(2) The file name “Convert.mdt” for the environmental setting and the file name “DataConvert.db” for 
the Parts Code Database are saved in separate Projectdata folder automatically. (They are kept 
even after the TPS software was closed) 

 
[Fig.40] Environmental setting 

 
[Fig.41] Property 

 
[Fig.42] Parts Code Database list 
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Click Load Data (Takaya format) File in Convert menu, and it displays Select Environmental Setting window (Fig.43). 

 
[Fig.43] Select Environmental Setting 

The Select Environmental Setting lists the Projectdata folders which contain the environmental setting. Click the 
Projectdata folder to see the contents of the environmental setting. 

 

Users can specify the registration destination of the Projectdata holder at “Environmental setting for 
convert folder” on the File/Folder window in Master mode. 

 
Property 
Click Property button on the Select Environmental Setting window, and it displays the Environmental setting window 
(Fig.40) which allows users to reconfigure various environmental settings as needed. 
 
Add 
Users can add a Projectdata folder for new environmental setting. Clicking the Add button to display the pop-up window 
(Fig.44), which allow users to specify the folder name. After specified the folder name, click the OK button. 

 
[Fig.44] Environmental setting name 

 
Copy 
Users can build a replica of the existing Projectdata folder. Point the cursor to the existing Projectdata folder (copy source) 
and click the Copy button, so that it displays the Environmental setting name window (Fig.44). After specified the folder 
name, click the OK button. 
 
Delete 
Users can delete the existing Projectdata folder as needed. (Cannot delete C:¥ TAKAYA folder) 
 



- 29 - 

XY Coordinates Input 
Users can input XY coordinates on either Step Edit (or Step List). 

 
[Fig.45] Edit menu 

 
[Fig.46] Step Edit list 

As shown in Fig.46, the Step Edit list is almost evenly divided into two sections: the PCB image is displayed on the upper 
side and the step data is on the lower side. 

 

The contents and the indication sequence of the Step Edit list is configurable on the Editor customize 
window in Master mode. 

 
Input method 
Two different Menu bars are available on the Step Edit list; one for Step data and another for PCB image. When users 
click on the step data, it displays the left Menu bar. But when they click on the PCB image, it displays the right Menu bar. 

    
(Menu bar for Step data)                      (Menu bar for PCB image) 

[Fig.47] Menu bar 

To facilitate the coordinates input on the PCB image, users can take advantage of “Area window”, “Zoom window” and 
“Point(s) zoom window selectable as option in Window menu. 

Area window This displays the whole PCB image to indicate the location on the PCB image where the 
cross-hair pointer is. 

Zoom window This magnifies the location on the PCB image where the cross-hair pointer is. 

Point(s) zoom window This magnifies the coordinates of H-pin and L-pin of the step data where the cursor is. 
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As for the menu on the Step Edit list, refer to Page 117. 

 
[Fig.48] Step Edit list 

The coordinate input of the 2-terminal components is made by either Manually-operated coordinate set or System-aided 
coordinate set in Tool menu. In addition, Generation function in Tool menu helps uses program steps to test the 
multi-terminal components (ex. IC, Transistors, Connectors). Tool menu is available by clicking on the step data list.  

 
[Fig.49] Tool menu 

 
Manually-operated coordinate set 
In Manually-operated coordinate set mode, the mouse operations is required to input XY coordinates and configure the 
High-fly zone etc. The cross-hair pointer on the PCB image indicates the XY coordinates of the test step where the 
mouse cursor is placed on. (Refer to Fig.50) 

 
[Fig.50] Manually-operated coordinate set 

Zoom Window 

Point(s) zoom window 
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How to use Manually-operated coordinate set function 
As the cross-hair point moves along with your clicking the left mouse button, set the cross-hair pointer on the XY 
coordinates which should be H-pin of the component and determine your change by clicking the right mouse button (or 
pressing the Enter key on the keyboard). 

 
[Fig.51] Specify H-pin 

 
Next, set the cross-hair pointer on the XY coordinates which should be L-pin of the component and determine your 
change by clicking the right mouse button (or pressing the Enter key on the keyboard). 

 
[Fig.52] Specify L-pin 

 
After both H-pin and L-pin positions were configured, the mouse cursor shifts to the next test step and the cross-hair 
pointer on the PCB image indicates the XY coordinates of the test step. 

 
[Fig.53] Moves to next step 

 

In order to change the XY coordinates of L-pin only, you just have to click the right mouse button (or 
press the Enter key on the keyboard) at the window where to specify H-pin. 
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System-aided coordinate set 
If the Takaya format data is specified by the XY coordinates at the center of each component, users can generate the 
probing points for both H-pin and L-pin automatically while using certain pitches registered in advance. Max. 10 pitches 
are registered at “Pitch Setting” in Aux menu. 

 
[Fig.54] Pitch Setting  

 
On the Pitch Setting window, users can register the whole length of components in Pitch column and define the Pitch 
offset column by specifying an offset value where should be contacted off from each edge of the components. 

 
[Fig.55] Pitch Setting window 

 
 
How to use System-aided coordinate set function 
Click System-aided coordinate set in Tool menu, and the cross-hair pointer on the PCB image indicates the XY 
coordinates of the test step where the mouse cursor is placed on. 

 
[Fig.56] System-aided coordinate set 
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Each time users press the Up and Down arrow key ([↑] [↓]) on the keyboard, two XY coordinates are generated in Y 
direction with assigned pitches automatically. In addition, pressing the Left and Right arrow key ([← ] [→ ]) generate two 
XY coordinates in X direction with the assigned pitches automatically. Users can determine the two points by clicking the 
right mouse button (or pressing the Enter key on the keyboard). 

 
[Fig.57] System-aided coordinate set 

 
Coordinate input for two-terminal components 
Move the mouse cursor on the test step and click either Manually-operated coordinate set or System-aided coordinate 
set in Tool menu (Refer to Fig.49).  
Refer to Page 30 for Manually-operated coordinate set and Page 32 for System-aided coordinate set. 
 
Coordinate input for multi-terminal components 
Click Generation in Tool menu (Refer to Fig.49). 
 
How to input XY coordinate of IC 
(1) After clicked Generation in Tool menu, it displays Generation window (Fig.58) where users can change “Comment” 

and “Location”. 

 
[Fig.58] Generation window 

 
(2) Click the Next button, it displays Data generation window (Fig.59). 

     
[Fig.59] Data generation window (Select generation type) 
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(3) After verified the box “IC automatic generation” is selected, click the Next button, and it displays the next window 
(Fig.60). 

      
[Fig.60] Data generation window (Select generation mode) 

 
(4) Specify appropriate generation mode and click the Next button, it displays the next window (Fig.61). 

     
[Fig.61] Data generation window (Select pitch) 

 
(5) Specify appropriate pitch and click the Next button, it displays the next window (Fig.62). 

     
[Fig.62] Data generation window (Select generation mode) 
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(6) Select “Regular generation” and click the Next button, and it displays the next window (Fig.63). 
For example of IC3, use the keyboard to enter “1, 8, 9, 16” in the edit box. 

      
[Fig.63] Data generation window (Input pin number) 

 
(7) Click the Next button, and it displays the next window (Fig.64). Specify the ground pin number of the IC. 

    
[Fig.64] Data generation window (Input Ground number) 

 

1. If the bottom probe is used to contact the ground pin on the B-side, select the box “Use Bottom 
ground” and specify the ground pin number. 

2. For “Pin to ground” and “IC open test”, users can register max 20 ground pins. (Refer to fig.65) In 
this case, the ground pin which is most close to the UUT is automatically selected by the TPS 
software during the data generation. 

3. When the box “Use ground coordinate” is selected, users don’t have to specify the ground pin. 

 

 
[Fig.65] Ground coordinate set 
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(8) Click the Next button, it displays the next window (Fig.66). Use the mouse to specify the XY coordinate at four corners 
of the IC in order (Pin #1, 8, 9, 16). 

 

[Fig.66] Specify contact points 

 

1. Click the left mouse button to move the cross-hair point to the XY coordinate and then click the right 
mouse button to determine the location. 

2. Use the Magnification bar to zoom in the image where the cross-hair pointer is. (Refer to Fig.67) 
3. If the PCB image should be moved, use the left mouse button to drag the image toward the direction 

where users want to move while pressing the Space key on the keyboard. 

 

 
[Fig.67] Specify contact points 

 
(9) Click the OK button, and it lists the step data aquatically generated on the display. (Refer to Fig.68) 

 
[Fig.68] List of automatically generated data 

 
There is the similar generation menu provided for the Transistors and the Connectors. 

 

Magnification bar 
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High-fly / No-contact-zone setting 

As each probe is installed with certain angles, the board under test is at risk of getting damage as well as the probes 
when the test points lie close to tall components. In addition, caution should be exercised in such boards that contain 
some particular components which stand in the way when the probes move around with L-position. In cases like this, 
users should set High-fly and No-contact-zone properly in the program. 
 
Setup procedure 
On the Step Edit list, drag a box around the area where should be set to High-fly / No-contact-zone with the mouse. Then 
click the right mouse button to select “Designate the area in the selection to High-fly / No-contact-zone” from the menu, 
and it displays High-fly / No-contact-zone setting window. (Refer to Fig.69) 

    
[Fig.69] High-fly / No-contact-zone setting window 

 
<< High-fly zone setting >> 
When the board contains some particular components which disturb the XY movement with keeping L-position, users 
should set High-fly zone so that the probes change the flying height automatically to avoid collision with the components 
only when they fly over them. (Refer to [D] in Fig.70) 
 

P1 P2 P3 P4 P1 P2 P3 P4

[A] [B]

C20 R20 R21 C21

 
 

P1 P2 P3 P4

No-contact-zone Top position of Probe

10mm
20mm

C30 C31

Probe Probe

[C] [D]

R22C22 C23

 
[Fig.70]  
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<< No-contact-zone setting >> 
When the test points lie close to tall components, users should set No-contact-zone so that Probe access is changed 
properly to avoid collision with the components. (Refer to [A] [B] in Fig.70) In addition, when the test points are 
surrounded by tall components, the probes are prohibited from contacting there. (Refer to [C] in Fig.70) 
The No-contact-zone steps in the program are indicated by blue color. 
 
The test steps that the probes have no chance to contact even if Probe access was changed and that the test point is 
inside the No-contact-zone are listed as “NC-NG error” on the display. (Refer to Fig.71) 

 
[Fig.71] NC-NG error list 

 

As for the setup procedure on the High-fly / No-contact-zone setting window, refer to the User’s guide for 
the APT-9411 Series. 

 

 

1. The High-fly / No-contact-zone setting window isn’t available unless the image files are loaded in the 
TPS software. (In this case, users should set High-fly / No-contact-zone in the APT-9411 Series.) 

2. To get a rough idea, the Height box on the High-fly / No-contact-zone window must be assigned to 
over than L-position. But use user’s discretion in setting it. 

3. If both High-fly zone and No-contact-zone are needed, be sure to select the two boxes of “High-fly 
zone” and “No-contact-zone” on the window. For the No-contact-zone, there is no way of assigning 
the height information, so that the probes move around without changing the flying height. That 
means, the probes are at risk of getting collision with the components. 

4. When the two boxes of “High-fly zone” and “No-contact-zone” are selected, the area on the image is 
surrounded by a red dashed line. 

5. If High-fly zone and No-contact-zone are configured in the program, the Probe access is changed 
automatically to avoid collision with the components. But users ultimately need to check it on the 
Step Edit list. 

 

Optimization 
Optimization in Tool menu consists of Sorting function and Combination measurement set function which are useful in 
reducing the test time to test the program. 
 

Data mode setting 
Refer to the User’s guide for the APT-9411 Series. 
 

Test mode setting 
Refer to the User’s guide for the APT-9411 Series. 
 

Data save 
Refer to the User’s guide for the APT-9411 Series. 
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Auto data conversion based on Parts library 
The TPS software manages Parts Code Database which is used to extract a test program from Takaya format data 
containing “Parts code” and “Shape code” so on automatically. The Parts Code Database is editable as users like. 

 Data

 Loading

TPS-4

Debug / Test

 Loading

Parts Code Database

 APT-9411

convert

Series

Test
 program 

 
[Fig.72] 

The TPS software is capable of loading image data (IMG file) taken by Real map function available as option for the 
APT-9411 Series or image data (BMP, JPG file) scanned in a scanner and taken by a digital camera. Thus users are 
allowed to set High-fly / No-contact-zone on the PCB image displayed on the monitor. 

 

1. In some image data, users cannot correct the distortion correctly. From time to time, the images 
taken by a digital camera is not so suitable to the TPS-4 because they are much curved at the top 
and the bottom and the ratio of expansion and contraction is nonconstant. 

2. As for the images scanned in a scanner, choose the one which has constant ratio of expansion and 
contraction. 

3. The image file must be saved in the same folder as the Takaya format data is. 
4. The TPS software is unable to load other than the image files with extension of IMG, BMP, JPG. 
5. In some images scanned in a scanner, they are ill-suited to the XY coordinates in a test program as 

the picture is unclear depending on the scanning condition so on. 
 

 

Users are recommended to use image data taken by Real map function available as option for the 
APT-9411 Series as the picture is clear and has less distortion. 

 
 
 
 
 

Takaya format data 
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Programming flowchart 

 
Data process in Takaya format data (Refer to Page 41) 

 
Environmental setting (Property) (Refer to Page 48) 

 
Data Conversion based on Parts Code Database (Refer to Page 63) 

 
Conversion error 

 

Edit the Parts code data at 
Error list (Refer to Page68) 

 
Optimization (Refer to Page 106) 

 
Data mode setting (Refer to Page 106) 

 
Test mode setting (Refer to Page 106) 

 
Data save (Refer to Page 106) 

 
Completion of test data programming by TPS  

 
 

Yes 

No 
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Data process in Takaya format data 

User should process a mount data file into the Takaya format data (extension .csv or .txt) prior to import to the TPS 
software.  

Basically, the Takaya format data should consist of Parts, Value, XY coordinates, SMD/THT, Mounting side, Angle, Parts 
code, Shape code, Side, No-in, Loc and Height as shown in List-6 below. But users don’t need to prepare all these items 
to import the Takaya format data in the TPS software. For instance, if the program was converted based on Parts, Value, 
XY Coordinates, SMD/THT and Mounting side only (means, Parts code is not available), the contact points would be 
substituted by the XY Coordinates in the Takaya format data automatically. 

 
Takaya format data 
List-6 indicates a sample data of when the mount data for the A-side and the B-side is saved in one file. 

Mark1 * 0 0 SMD TOP 0 * * * *  
Mark2 * 93.98 104.0603 SMD TOP 0 * * * *  
JP1 * 83.7899 -16.5499 THT TOP 180 RES2 R¥ 400 * 1A  
CN5 * 116.8099 -0.0199 THT TOP 270 HRSDF1E2P HRSDF1E2P * 1A 7 
CN4 * 116.8099 15.2601 THT TOP 270 HRSDF1E4P HRSDF1E4P * 1B 7 
R46 No-in 86.0759 74.8901 SMD TOP 180 331J SM¥ 1.6-0.8 No-in 1B  
R45 330O 86.0759 79.9701 SMD TOP 180 331J SM¥ 1.6-0.8 * 1C  
R8 No-in 71.0899 79.7161 SMD TOP 90 OP SM¥ 1.6-0.8 No-in 1C  
R7 No-in 78.7099 79.7161 SMD TOP 270 OP SM¥ 1.6-0.8 No-in 2A  
IC6 * 57.1199 96.4801 SMD TOP 0 HD74HC14AF SOP14 * 2A  
IC16 * 88.2349 97.1151 SMD BTM 0 HD26C31 SOP16 * 2B  
BC10 330nF 45.6899 -14.8989 SMD BTM 270 334Z SM¥ 1.6-0.8 * 2B  
            
Parts Value X-coor Y-coor SMD/THT Mounting side Angle Parts code Shape code No-in Loc Height 

[List-6] Sample data 
 
Parts 
This is name of component or UUT (ex. R1, R2… , IC101, IC102). (English one byte characters, max 11 letters) 
 
Value 
This is value of component. (English one byte characters, max 11 letters) When there is no information included in the 
mount data, use the keyboard to enter it manually in reference to List-2 below. 

Resistor Unit must be specified by “Ω ”. (Use “O” key of the alphabet) ex. 47O , 2.2KO, 1MO 

Capacitor 
Unit must be specified by “F”. ex. 22pF, 10nF, 47uF 
The Value of less than 1uF can be specified by color code. 
ex. 100pF →  101, 1000pF →  102, 10nF →  103, 0.1uF  →  104 

Inductor Unit must be specified by “H”. ex. 10uH, 2.2mH 
No placement Specify “No-in”, and the Function of Measuring condition is substituted by “JP” automatically. 
Others Specify asterisk (*) for the components that require nothing in the Value. 

[List-7] Rule of specifying Value 
 
X-coor / Y-coor 
This is XY coordinates of the components. The unit is assignable to mm, 100um, 10um, um or Inch in Convert > 
Environmental setting > Property > Unit of Coordinate. When the mount data uses other than above unit, convert it to any 
of mm, 100um, 10um, um or Inch, 

When the A-side isn’t separated from the B-side (means one file), the XY coordinates of SMD at the B-side must be 
described with the XY coordinates viewed (see through) from the A-side. In addition, users should specify the Board 
reference point for both the A-side and the B-side to be the same point, in view of the A-side. 
 



- 42 - 

SMD/THT (Surface-mounted components / Components inserted in the through holes) 
This is information on the state of loaded components. (max 8 letters) Users should specify either SMD or THT. The letter 
strings of THT is assignable within 3 types (Ex. “DIP”, “THT”) at Convert > Environmental setting > Property > 
Identification code (THT). Other than these three letter strings assigned here is judged to manage as SMD. 
 
Mounting side 
This is information on the Mounting side (A-side or B-side). (max. 8 letters) The letter strings of the Mounting side is 
assignable within 3 types (Ex. “B”, “BTM”) at Convert > Environmental setting > Property > Identification code (B-side). 
Other than these three letter strings assigned here is judged to manage as B-side. 
When the A-side and the B-side are managed in different files, the information on Mounting side is unnecessary. 
 
Angle 
This is information on the angle of loaded components and configurable by the degree. Users can define the direction of 
angle to either Counterclockwise or Clockwise at the box “Direction of rotation” on the Property window of Environmental 
setting in Tool menu. 
 
Parts code 
This is a specific code of loaded components. (max. 50 letters) The Parts Code Database managed in the TPS software 
enables to convert the Takaya format data to the high-quality finished test program, owing to the Parts code containing 
information on Value, EL, Pins, Offset value and Size dimensions. 
 
Shape code 
This is size information of loaded components. (max. 50 letters) 

 
The size information is managed in Parts code when Shape code isn’t available.  

 
No-in 
Specify “No-in” for example when the data conversion isn’t required because no component is loaded on the board. (max. 
8 letters) The letter strings is assignable within 3 types at Convert > Environmental setting > Property > Identification code 
(No-in). 
 
Loc 
This is position information of loaded components. ex. 1A, 1B, 1C… (max. 4 letters) This is omissible by assigning the 
letter strings “**” for example, because it’s possible to generate automatically on the APT-9411 Series later 
 
Height 
This is height information on loaded components. (unit mm) The information is substituted into the box “Height” on the 
Property window in the Parts Code Database automatically. 
 
Delimiter used in Takaya format data 
Users can select the appropriate delimiter from Comma, Space, Semicolon or Tab. Users can define the delimiter in the 
Environmental setting window. 
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Example of Takaya format data 

( Example 1 ) 
Let’s assume that Takaya format data consists of Parts, Value and XY coordinates as shown in List-8 below. 

Mark1 * 0 0 
Mark2 * 93.98 104.0603 
JP1 * 83.7899 -16.5499 
CN5 * 116.8099 -0.0199 
CN4 * 116.8099 15.2601 
R46 No-in 86.0759 74.8901 
R45 330O 86.0759 79.9701 
R8 No-in 71.0899 79.7161 
R7 No-in 78.7099 79.7161 
IC6 * 57.1199 96.4801 
IC16 * 88.2349 97.1151 
BC10 330nF 45.6899 -14.8989 
    
Parts Value X-coor Y-coor 

[List-8] 

If this Takaya format data is converted in the TPS software, only Parts name, Value and XY coordinates at the position 
where the components are loaded are generated. Because there was no Parts code included in the Takaya format data, 
no accurate contact point is output in the test program. Thus users should input the contact points manually on the TPS 
software or the APT-9411 Series. 
 

( Example 2 ) 
Let’s assume that Takaya format data consists of Parts, Value, XY coordinates, SMD/THT, Angle and Parts code as 
shown in List-9 below. 

Mark1 * 0 0 SMD 0 * 
Mark2 * 93.98 104.0603 SMD 0 * 
JP1 * 83.7899 -16.5499 THT 180 RES2 
CN5 * 116.8099 -0.0199 THT 270 HRSDF1E2P 
CN4 * 116.8099 15.2601 THT 270 HRSDF1E4P 
R46 No-in 86.0759 74.8901 SMD 180 331J 
R45 330O 86.0759 79.9701 SMD 180 331J 
R8 No-in 71.0899 79.7161 SMD 90 OP 
R7 No-in 78.7099 79.7161 SMD 270 OP 
IC6 * 57.1199 96.4801 SMD 0 HD74HC14AF 
IC16 * 88.2349 97.1151 SMD 0 HD26C31 
BC10 330nF 45.6899 -14.8989 SMD 270 334Z 
       

Parts Value X-coor Y-coor SMD/THT Angle Parts code 
[List-9] 
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If this Takaya format data is converted in the TPS software, Parts name, Value and the contact points are generated. But 
if any appropriate Parts code is not available or some error is found in the Parts Code Database, it displays an error 
message while indicating number of the error detected. (Refer to Fig.73) 

 
[Fig.73] Error window under data conversion 

Click on the Error List button to go to the Conversion Error List window (Fig.74). 

 
[Fig.74] Conversion Error List window 

Click on the Edit button after placed the mouse cursor on the Conversion Error List, and it displays the Property window 
of the Parts code data. After the Parts code data was corrected or updated with new entry (For details to Error List in 
Page 68), click on the OK button. The same operation is required for the other errors if there are. After the Parts Code 
Database was edited completely, click the Close button on Fig.74 to go back to Fig.73. Then click the Retry button to 
perform the data conversion again. 
 

( Example 3 ) 
Let’s assume that Takaya format data consists of Parts, Value, XY coordinates, SMD/THT, Angle, Parts code and Shape 
code as shown in List-10 below. 

Mark1 * 0 0 SMD 0 * *  
Mark2 * 93.98 104.0603 SMD 0 * *  
JP1 * 83.7899 -16.5499 THT 180 RES2 R¥ 400  
CN5 * 116.8099 -0.0199 THT 270 HRSDF1E2P HRSDF1E2P  
CN4 * 116.8099 15.2601 THT 270 HRSDF1E4P HRSDF1E4P  
R46 No-in 86.0759 74.8901 SMD 180 331J SM¥ 1.6-0.8  
R45 330O 86.0759 79.9701 SMD 180 331J SM¥ 1.6-0.8  
R8 No-in 71.0899 79.7161 SMD 90 OP SM¥ 1.6-0.8  
R7 No-in 78.7099 79.7161 SMD 270 OP SM¥ 1.6-0.8  
IC6 * 57.1199 96.4801 SMD 0 HD74HC14AF SOP14  
IC16 * 88.2349 97.1151 SMD 0 HD26C31 SOP16  
BC10 330nF 45.6899 -14.8989 SMD 270 334Z SM¥ 1.6-0.8  
         
Parts Value X-coor Y-coor SMD/THT Angle Parts code Shape code  

[List-10] 
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There is the same outcome in Example 3 just as there’s in Example 2. But one big difference is Example 3 has Shape 
code in the Takaya format data. As the Shape code contains “Category of parts”, “Reference point”, “Angle”, “Pin” and 
“Size”, the information is substituted in Property of the Parts code data automatically even when the Parts code has not 
been registered there yet. 

 
[Fig.75] Property in Parts Code Database 

 
Board reference point and Aux reference point 
Neither the edge nor the hole of the board is suitable for the Board reference point and the Aux. reference point used in 
the test program. If there are fiducial marks on the board, give this priority. In addition, if there is known offset value 
between the origin point and the fiducial marks in the mount data, the fiducial mark could be the Board reference point 
after the data conversion. 
 
Board reference point 
Users should register appropriate identification code (ex. Mark1) at “Identification code (Reference)” (Convert > 
Environmental setting > Property) in advance, in order to make it possible to recognize the fiducial mark and assign to the 
Board reference point automatically. If more than one step contains the letter strings registered in the Identification code 
(Reference), the TPS software is designed to convert the fiducial mark at the step which is the most closest to the top 
step to the Board reference point. 

 

When the A-side and the B-side are managed in the same file, users should specify the fiducial marks 
separately for the A-side and the B-side. Therefore, the Mounting side in the Takaya format data must 
be specified by the letter strings registered in “Identification code (B-side)” (Convert > Environmental 
setting > Property) in advance, in order to identify which fiducial mark it is. 

 
Aux reference point 1 
Users should specify Aux reference point 1 if they want to use the Coordinate amend function to correct possible 
inclination of the board. Aux reference point 1 should be specified to the fiducial mark which is as diagonally far as 
possible from the Board reference point. 
Users should register appropriate identification code (ex. Mark2) at “Identification code (Aux-1)” (Convert > Environmental 
setting > Property) in advance, in order to make it possible to recognize the fiducial mark and assign to the Aux reference 
point automatically. If more than one step contains the letter strings registered in the Identification code (Aux-1), the TPS 
software is designed to convert the fiducial mark at the step which is the most closest to the top step to the Aux reference 
point 1. 
 
Aux reference point 2 
In addition to Aux reference point 1, users should specify Aux reference point 2 if they want to use the Coordinate amend 
function to correct possible inclination and scale of the board. Aux reference point 2 should be specified to the fiducial 
mark which forms a triangular shape by Board reference point and Aux reference point 1. 
Users should register appropriate identification code (ex. Mark3) at “Identification code (Aux-2)” (Convert > Environmental 
setting > Property) in advance, in order to make it possible to recognize the fiducial mark and assign to the Aux reference 
point automatically. If more than one step contains the letter strings registered in the Identification code (Aux-2), the TPS 
software is designed to convert the fiducial mark at the step which is the most closest to the top step to the Aux reference 
point 2. 

 

When the A-side and the B-side are managed in the same file, users should specify the fiducial marks 
separately for the A-side and the B-side. Therefore, the Mounting side in the Takaya format data must 
be specified by the letter strings registered in “Identification code (B-side)” (Convert > Environmental 
setting > Property) in advance, in order to identify which fiducial mark it is. 
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Data for B-side 
When A-side and B-side are managed in different files: 

 XY coordinates  
Users should use XY coordinates viewed from the B-side which are originated from the Board reference point on the 
B-side. 

B-side(Turn over in X-direction)

YY
X

Y Y

X

A-side
BRP(B-side)BRP(A-side)  

[Fig.76] A-side and B-side are in different files 
 
 Angle  
XY coordinates on the B-side are turned around in the same direction as the A-side (ex. Counterclockwise). 
 
 SMT/THT  
Users should add information of SMT/THT when SMT and THT components are mixed in Takaya format data. 
 
 
When A-side and B-side are managed in the same file: 

 XY coordinates  
Users should use XY coordinates viewed (see through) from the A-side. The two origin points (to be converted to the 
Board reference points) for the A-side and the B-side should be the same point when the B-side was viewed (see 
through) from the A-side. (ex. the edge or the hole of the A-side) 

YY
X

Parts(A-side) Parts(B-side)

A-side
BRP(A/B-side)  
[Fig.77] A-side and B-side are in the same file 
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 Angle  
XY coordinates on the B-side are turned around in the same direction as the A-side. (ex. Counterclockwise) 
Fig.78 indicates that XY coordinates on the B-side viewed (see through) from the A-side are turned counterclockwise. 
(The direction of the rotation is configurable in the Environmental setting menu) 

0 Degree 90 Degrees

180 Degrees

1

270 Degrees

1

 
[Fig.78] Angle to turn counterclockwise 

 
 Mounting side  
Users should add information on the Mounting side. 
 
 SMT/THT  
Users should add information of SMT/THT when SMT and THT components are mixed in Takaya format data. 
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Environmental Setting (Property) 
Click Environmental Setting in Convert menu to specify the direction to convert B-side data so on. In addition, the 
Property window allows users to configure Takaya format data and select unit of coordinates from mm, 100um, 10um, 
um or Inch. 

 

1. The Environmental Setting window (Fig.80) appears to be configurable also when the Takaya format 
data is imported. 

2. The changes in the Environmental Setting window is saved in the folder called “Projectdata”. Users 
can save different Environmental Settings in plural Project folders. 

3. Users can specify the Projectdata folder each time the Takaya format data is imported.  
(Refer to Projectdata folder in Page 27) 

 
Click Environmental Setting in Convert menu to open the Environmental Setting window (Fig.79). 

 
[Fig.79] Environmental Setting in Convert menu 

Clicking on the Property button on the Environmental Setting window to go to Property window (Fig.81). 

 
[Fig.80] Environmental Setting window 

 
[Fig.81] Property window 
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Items / Read Items 
Users can configure the Takaya format data by selecting the items necessary to import (Parts, Value, XY coordinates, 
SMD/THT, Mounting side etc) and the sequence as they want. Clicking [ < ] or [ > ] button is able to move the selected 
items to another side. (Click [ << ] or [ >> ] button only when all the items have to move to another side at one time) In 
addition, Clicking [Up] and [Down] buttons are able to change the sequence of the selected items in the Read Items box. 

 
[Fig.82] Items / Read Items 

 

When “Read Items” wasn’t configured exactly as per the Takaya format data to import, the data won’t be 
converted properly or some warning error would appear during the data conversion. 

 
Select separator 
Choose the appropriate separator from the right pull-down menu. 

 

 

If this was set wrong, the data won’t be converted properly or some warning error would appear during 
the data conversion. 

 
Unit of Coordinates 
Choose the appropriate unit of coordinates from the right pull-down menu. 

 

 

If this was set wrong, neither the camera nor the probes would move to the correct location or some 
warning error would appear during the data conversion. 

 
Direction of rotation 
Choose direction of rotation which is applied at a data loading from the right pull-down menu. 

 

 
If this was set wrong, neither the camera nor the probes would move to the correct location. 
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Reference point (SMD) 
Choose a reference point of SMDs specified in the Takaya format data from the right pull-down menu. The contact points 
are generated based on this reference point. When users want to use different point for the SMDs, it’s also possible to 
specify it for individual Parts code in the Parts Code Database. 

 

 
If this was set wrong, neither the camera nor the probes would move to the correct location. 

 
Reference point (THT) 
Choose a reference point of THTs specified in the Takaya format data from the right pull-down menu. The contact points 
are generated based on this reference point. When users want to use different point for the THTs, it’s also possible to 
specify it for individual Parts code in the Parts Code Database. 

 

 
If this was set wrong, neither the camera nor the probes would move to the correct location. 

 
Identification code (THT) 
Users can register maximum 3 kinds of identification codes (letter strings) for THT components described in “SMD/THT” 
of the Takaya format data. 

 
[Fig.83] Identification code (THT) 

 

If this was set wrong, it would misjudge the SMD/THT components or some warning error would appear 
during the data conversion. 

 
Identification code (B-side) 
Users can register maximum 3 kinds of identification codes (letter strings) for B-side components described in “Mounting 
side” of the Takaya format data. 

 
[Fig.84] Identification code (B-side) 

 

If this was set wrong, it would misjudge the Mounting side or some warning error would appear during 
the data conversion. 

 
Identification code (No-in) 
Users can register maximum 3 kinds of identification codes (letter strings) described in “No-in” of the Takaya format data. 
If the Takaya format data designates contains the letter strings specified here, no data are generated for them. 

 
[Fig.85] Identification code (No-in) 

 

If this was set wrong, it would misjudge the No-in devices or some warning error would appear during 
the data conversion. 
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Identification code (Reference) 
Users can register maximum 3 kinds of letter strings so that the Board reference point moves to the point assigned at any 
of these steps when the Takaya format data is loaded. If more than one step contains the Identification code (Reference), 
the Board reference point moves to the point at the step which is the most closest to the top step. 

 
[Fig.86] Identification code (Reference) 

 

If this was set wrong, the Board reference point won’t be set correctly or some warning error would 
appear during the data conversion. 

 
Identification code (Aux-1) 
Users can register maximum 3 kinds of letter strings so that the Aux reference point 1 moves to the point assigned at any 
of these steps when the Takaya format data is loaded. If more than one step contains the Identification code (Aux-1), the 
Aux reference point 1 moves to the point at the step which is the most closest to the top step. 

 
[Fig.87] Identification code (Aux-1) 

 

If this was set wrong, the Aux reference point 1 won’t be set correctly or some warning error would 
appear during the data conversion. 

 
Identification code (Aux-2) 
Users can register maximum 3 kinds of letter strings so that the Aux reference point 2 moves to the point assigned at any 
of these steps when the Takaya format data is loaded. If more than one step contains the Identification code (Aux-2), the 
Aux reference point 2 moves to the point at the step which is the most closest to the top step. 

 
[Fig.88] Identification code (Aux-2) 

 

If this was set wrong, the Aux reference point 2 won’t be set correctly or some warning error would 
appear during the data conversion. 

 
Separate file for A-side and B-side 
Users should check the box only when loading the Takaya format data which is separated in two different files for the 
A-side and the B-side. In this case, the Load Data (Takaya format) File in Convert menu asks user to load the Takaya 
format data separately for the A-side and the B-side as shown in the left window of Fig.89. Users should not check the 
box when loading the Takaya format data where the A-side and the B-side are managed in the same file. In this case, the 
Load Data (Takaya format) File in Convert menu is the right window in Fig.89. 

  
Separate files for A/B-side                               Same file for A/B-side 

[Fig.89] 
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Use Nominal value conversion 
“Nominal value conversion” should be done only when users want to inspect the first PCB which SMDs were placed by 
the Pick/Place Machine using a double-faced adhesive tape. (This aims to make sure if the Pick/Place Machine placed 
the SMDs of the regulation value before he is engaged in quantity production) If the box is selected, it displays additional 
window (Fig.90) for users to choose Nominal value conversion in the process of the data conversion. 

 
[Fig.90] Data conversion window 

 
Only if Function “F” in the Parts Code Database list is substituted by “CV”, the TPS can convert the Takaya format data to 
nominal value inspection data. (i.e. Step 00007 ~ 000009 in Fig.91) 

 
[Fig.91] Nominal conversion 

 
If the box “Use Nominal value conversion” is selected, the Parts Code Database list displays “Off-I” as Nominal value 
conversion offset. (Refer to Fig.92) 

 
[Fig.92]  

 
Nominal value conversion offset (Off-I) specifies the probing points added by minus offset from both edges of the 
components. (Refer to Fig.93) 

 Size-P

Probe Probe

 Off-I  Off-I

 
[Fig.93] Nominal value conversion offset (Off-I) 

 

Nominal value conversion offset (Off-I) 
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Use two normal offset value 
If the checkbox is selected, users can assign two kinds of plus offset from both edges of the components. Any one of 
these two offsets can be specified in the process of Normal conversion. 
 

 
[Fig.94] 

 
Normal conversion offset specifies the probing points added by plus offset from both edges of the components.  
(Refer to Fig.95) 

Size-P

ProbeProbe

Offset value Offset value
 

[Fig.95] Normal conversion offset 
 
Correct distortion of the image prior to loading the JPG/BMP file 
Users should select the box “Correct distortion of the image prior to loading the JPG/BMP file” when they load either JPG 
or BMP file in the TPS software. 
 

Normal conversion offsets (Off-1,2) 
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Standard angle 
Users should register “Standard angle” (0 degree) used at the Pick/Place Machine with respect to each components. 
Click the Standard angle button, and it displays Fig.96. 

 
[Fig.96] Standard angle 

 
The standard angle users should register is displayed at the right column of the window. For example, Fig.97 indicates 
each angle of Mini-module 3-terminal device. After registered any one from them, click the OK button. 

 
[Fig.97] 

 

The standard angle (0 degree) must be registered on a component to component basis. The standard 
angle is saved in Convert.Mdt file under the Projectdata folder. Users should create a new Convert.Mdt 
file under the Projectdata folder each time they load the Takaya format data including different standard 
angle. 
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Environmental setting 

After the Property window setting was completed, move back to the Environmental setting window (Fig.98) to make 
necessary settings there. 

 
[Fig.98] Environmental setting window 

 
Direction to convert B-side data 
<< When users import Takaya format data which the A-side and the B-side are managed in the different files >> 
To test the THT components at A-side, users should change them to B-side. They can specify the invert direction to 
either X-direction or Y-direction. 

<< When users import Takaya format data which the A-side and the B-side are managed in the same file >> 
Users should specify the invert direction of B-side data to either X-direction or Y-direction. 

基 板 原 点

基 板 原 点

基 板 原 点

Turn over in X-direction

Turn over in Y-direction

A-side B-side

B-side

BRP

BRP

BRP

 
[Fig.99] 

 
Offset value for normal test (Off-1) / (Off-2) 
If there is new Parts code found in the process of Normal conversion (Refer to Fig.90), this value is saved as default 
automatically in the Parts Code Database. Specify them within 0.000 mm ~ 9.999 mm. 
 
Offset value for nominal value check (Off-I) 
If there is new Parts code found in the process of Nominal value conversion (Refer to Fig.90), this value is saved as 
default automatically in the Parts Code Database. Specify them within 0.000 mm ~ 9.999 mm. 
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Device set by parts name 
The function “EL” on the Parts Code Database is automatically set during the data conversion according to the capital 
letters registered on this window. 

 
[Fig.100] Device set by parts name 

 
Set Block copy items 
This allows users to specify the target items to be copied by executing “Implement block copy” on Edit menu in the Parts 
Code Database list. Check the box of the items if they should be copied. 

 
[Fig.101] Set Block copy items 
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Parts library-based data conversion 

The process of the Parts library-based data conversion which is available by the Parts code included in the Takaya 
format data is basically no difference from above-referenced normal data conversion. 
 
Operation procedure 
(1) Choose “Load Data (TAKAYA format) File” from Convert menu. (Refer to Fig.102) 

 
[Fig.102] Load Data (TAKAYA format) File 

 
(2) The TPS software opens the Select Environmental Setting window for users to select a Projectdata folder. (Refer to 

Fig.103) Choose an appropriate Projectdata folder from the list. In addition, users can create a Projectdata folder 
referring to “Projectdata folder” in Page 27. 

 
[Fig.103] Select Environmental Setting 

 

Right after Load Data (TAKAYA format) File was selected from Convert menu, the Data Conversion 
window (Fig.104) appears without displaying the Select Environmental Setting window unless the box 
“Maintain more than one environmental setting for convert” on File/Folder menu in Master mode is 
selected. 

 
(3) The TPS software opens Data Conversion window. 

 

[Fig.104] Data Conversion 
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Select Data (Text/CSV) File > Data File Name (A-side) 
Click the right browser button to select the file for A-side (Top side) from the specified folder. 

Select Data (Text/CSV) File >Data File Name (B-side) 
Click the right browser button to select the file for B-side (Bottom side) from the specified folder. 

Select Image (IMG / BMP / JPG) File > Image File Name (A-side) / (B-side) 
Click the right browser button to select the image data file for A-side / B-side from the specified folder. 

Distance between origins at A-side and B-side 
Users should specify the exact distance between two origin points on A-side and B-side of the Takaya format data. 
This could be the offset value to have the probes contact the THT components available on A-side from B-side. 

A-side

THT(A-side)

SMD(B-side)

X-distance

BRP(A-side) BRP(B-side)  
[Fig.105] Distance between origins at A-side and B-side 

 

1. “Distance between origins at A-side and B-side” is displayed only when the Takaya format data is 
managed in two separate files for Side-A and Side-B. 

2. When the Takaya format data is managed in the same file for Side-A and Side-B, it displays 
Fig.106. 

 
[Fig.106] Data File Name 

 
(4) After the Data Conversion window was configured properly, click the Next button to open the Data Conversion 

window that allows user to select Conversion method and Offset to use. 

 
[Fig.107] Data Conversion window 

 



- 59 - 

Conversion method and Offset 
Normal The Takaya format data is converted in normal program to inspect the PCB where the loaded 

components are fit with soldering. Users should specify either Offset-1 or Offset-2 only when 
the box “Normal” is selected. 

Nominal value The Takaya format data is converted in special program to inspect the first PCB which SMDs 
were placed by the Pick/Place Machine using a double-faced adhesive tape (no soldering). In 
addition, only if Function “F” in the Parts Code Database list is substituted by “CV”, the TPS 
can convert to nominal value inspection data. 

Offset-1,2 User should specify either Offset-1 or Offset-2 only when the box “Normal” is selected. The 
Offset-1,2 is to specify plus offset from both edges of loaded components. 

 

 

1. The Data Conversion window is displayed only when the box “Use Nominal value conversion” 
(Environmental setting > Property) is selected. 

2. The Offset-2 is displayed on the Data Conversion window only when the box “Use two normal offset 
value” (Environmental setting > Property) is selected. 

 

 

The Nominal value conversion should be done while the Parts Code Database is well configured not to 
cause any conversion error. For this, users are recommended to first perform Normal conversion to 
successfully complete the Parts Code Database in advance. 

 
(5) After the Data Conversion window was configured properly, click the Execute button to load the Takaya format data 

and the image files at the same time. 
 
(6) The TPS software takes some time to convert the Takaya format data and it displays Real Map Adjustment window 

(Fig.108) where users can fit the PCB image of A-side to the transmissive PCB image of B-side. 

 
[Fig.108] Real Map Adjustment 

 

The TPS software assumes the PCB image of B-side that was reversed in “Y-direction”. If the TPS 
software loads the PCB image of B-side which was reversed in X-direction, users cannot work out this 
operation until the PCB image of B-side is revised to the correct direction. Be sure to select “X-Reverse 
Turn” on the bottom of the window if the PCB image of B-side was captured after they reversed the PCB 
in X-direction. 
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(7) Use the arrow keys on Fig.108 to fit the PCB image of A-side to the transmissive PCB image of B-side and click the 
OK button. 

 
[Fig.109] Fit the PCB images for A-side and B-side 

 
(8) It displays Board reference point set window (Fig.110). Set the cross-hair pointer on the Board reference point and 

click the Next button. 

 
[Fig.110] Board reference point set 

 
(9) It displays Aux reference point set window (Fig.111). Set the cross-hair pointer on the Aux reference point and click 

the Next button. 

 
[Fig.111] Aux reference point set 
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(10) When there is data of B-side, it displays another window (Fig.112) where users should configure the Board reference 
point and the Aux reference point. Configure them in the same manner and click the Next button. 

 
[Fig.112] Configure B-side 

 
(11) It displays Data Conversion window (Fig.113). Click the Close button to finish the data conversion. 

 
[Fig.113] Data Conversion (IMG file) 

(Remarks)  
When some error was detected in the process of the data conversion, it displays Fig.114 below, instead of Fig.113. 

 
[Fig.114] Error window under data conversion 

 
Click on the Error List button to go to the Conversion Error List window (Fig.115). 

 
[Fig.115] Conversion Error List window 
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Click on the Edit button after placed the mouse cursor on the Conversion Error List, and it displays the Property window 
of the Parts code data. After the Parts code data was corrected or updated with new entry (For details to Error List in 
Page 68), click on the OK button. The same operation is required for the other errors if there are. After the Parts code 
data was edited completely, click the Close button on Fig.115 to go back to Fig.114. Then click the Retry button to 
perform the data conversion again. 

 

Even after the data was converted, users can click the Angle button to turn the XY coordinates 
counterclockwise by 90 degrees as needed. In addition, the button “Reverse turn” enables users to turn 
the XY coordinates on the B-side in reverse if they are the ones viewed (see through) from the A-side in 
the Takaya format data. 

                              
[Fig.116] 

 
Loading of BMP, JPG file 
Concerning the process of data conversion using BMP and JPG files, refer to Page 24. 
 
 

Angle 

Reverse turn 

Point size 

Gain 
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Data Conversion based on Parts Code Database 

Users should build up the Parts Code Database properly to implement the above-referenced data conversion based on 
Parts library. The Parts Code Database consists of Parts code, Value, EL, Pins, G-pin, Offsets, Category (=Shape code) 
etc as shown in Fig.117. 

 
[Fig.117] Parts Code Database list 

At the time of loading the Takaya format data in the TPS software, new Parts code is added in the Parts Code Database 
automatically if it has not been registered yet. But users should input other than the Parts code (ex. Value, EL so on) 
manually based on information materials of the components. (Refer to Fig.118) 

 

Parts code
Database

 

Data

Value
EL (Element)
Pins (Pin number)
G-pin (GND pin number)
AT (Attribute)

Parts code Manual input

 
 

[Fig.118] 

The Parts Code Database is “DataConvert.db” inside the Projectdata folder named “TAKAYA”. 
 
No. 
This is line number of the list and is unmodificable. 
 
Parts code 
This is particular code of each component which is assignable within 50 letters. 
 
Value 
This is nominal value of component which is assignable within 11 letters. At the time of converting the Takaya format data, 
this value is substituted in Value of the test program. 
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EL (Element) 
This is device characteristic of component. At the time of converting the Takaya format data, EL is substituted by any of 
following characters automatically according to the capital letters assigned by “Device set by Parts name” in 
Environmental setting menu. In cases when there was nothing that apply the registration data, the asterisk symbol (*) is 
substituted instead. Any corrections of EL should be referred to following table. 

EL EL 
Registers R 
Capacitors C 
Inductors L 
Diodes D 
Transistors Q 
IC IC 
Photo couplers PC 
Register arrays RA 
Volumes VR 
Crystals X 
Jumpers JW 
Connectors CN 
Fuses F 
Switches SW 
Filters FL 
FET FE 

 
Pins (Pin number) 
This is the number of electrode (terminal) of component. 
 
G-Pin (GND pin number) 
This is the pin number of GND or common lead of the IC. 
 
F. (Function) 
Two flags “NC” and “CV” are assignable in Function column. 
When “NC” is substituted in F, the list is displayed in red and the data isn’t converted. 
When “CV” is substituted in F, the list is displayed in blue and the TPS can convert the Takaya format data to nominal 
value inspection data. 
 
+% -% 
This is upper/lower tolerance limits for Pass/Fail judgment in test. 
 
Off-1 / Off-2 (Offset) 
They specify the probing points added by plus offset from both edges of the components. The values are assignable 
within 0.000 mm ~ 9.999 mm for Normal conversion. (Refer to Fig.119) 

Off-1/Off-2 Off-1/Off-2

Size-P

ProbeProbe

 
[Fig.119] Off-1/Off-2 
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The setting requires careful attention… this is because if the offset was too big, the probing point would go off the test land. 
If too small, the probe would hit directly on the electrode of the component when it moved over a little. The test lands differ 
according to the PCB and the components (Resistors, Capacitors, IC and Transistors, so on), so that users should set 
appropriate offset values while checking on the APT-9411 Series. 

 

At the time of adding new Parts code to the Parts Code Database, Off-1 / Off-2 are automatically 
substituted by default values assigned at “Offset value for normal test (Off-1)” and “Offset value for 
normal test (Off-2)”on the Environmental setting window. 
In addition, the offset values have no application to DIP components and odd-shaped components. 

 
Off-I (Offset) 
This specifies the probing points added by minus offset from both edges of the components when the probes are used in 
nominal value inspection. 

Size-P

Probe

Off-I Off-I

Probe

 
[Fig.120] Off-I 

 

At the time of adding new Parts code to the Parts Code Database, Off-I is automatically substituted by 
default value assigned at “Offset value for nominal value check (Off-I)” on the Environmental setting 
window. 

 
Shape code 
The Shape code has information about “Size”, “Offset” and “Category of parts”. Thus the TPS software takes “Category 
of parts”, “Reference point”, “Angle”, “Pin” and “Size” from them to substitute in Property automatically at the time of 
adding new Parts code to the Parts Code Database in the process of the data conversion. In addition, the other 
parameters (ex. “Offset”, “Zone”, “Permission”) are substituted by the default values. 
 
AT (Attribute) 
This is the attribute of component and is unmodificable. 
In cases when EL (Element) is Q, PC, D, RA, SW, VR, FL, X, IC or FET, use AT (attribute) to specify combination of 
terminals to test. 
 
Category of parts 
This is the type of component. For reasons of expediency, they are named by such components with typical shape (ex. 
CHIP, SOP). For SMD-type 2-terminal components (ex. Tantalum capacitor, Aluminum electrolytic capacitor), users 
should specify them to CHIP. Clicking the Category of parts button to got to another screen which shows the outline 
drawings by sample, so users should choose the one which is most close in shape. 
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Explanation of Parts Code Database window 
 
Edit menu 

Set the block copy source / Select the block copy destination / Implement the block copy 
When the Parts Code Database was updated with new entry, users can copy such information about Pins, Attribute 
and Category of parts already registered in the existing data and past it to new data. 

 
1. Place the mouse cursor on the source line in the Parts Code Database list and select “Set the block copy source” 

from Edit menu. Then the source line changes to pink color. (Refer to No. 000001 in Fig.121) 

 
[Fig.121] Block copy 

 
2. Place the mouse cursor on the destination line and select “Select the block copy destination” from Edit menu. 

Then the destination line changes to green color. (Refer to No.000007 in Fig.122) 

 
[Fig.122] Block copy 

 
3. Select “Implement the block copy” from Edit menu, and the TPS software copy and past the information from its 

source to its destination. 

 
[Fig.123] Block copy 

 

The content to be copied is assignable at “Set Block copy items” on the Environmental setting window in 
Convert menu. 

 
1 Line Insert 
Users can insert a new line in the line where the cursor is blinking. Parts code and Value etc are substituted by 
asterisk (*) automatically, so users should enter other information as needed. 

1 Line Cut 
Users can cut the line where the cursor is blinking from the Parts Code Database list. 

Erase 
Users can cut the specified lines from the Parts Code Database list in block. 
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Search menu 
Search parts code database 
Users can search and list the steps that match the criteria specified. (ex. Parts code, Value)  

Forward 
Users can search the specified letter strings in descend direction to list the steps.  

Previous 
Users can search the specified letter strings in upper direction to list the steps. 

Replace 
Users can search the specified letter strings to replace by other ones. 

 
Move menu 

Move to Specified List 
Users can move the mouse cursor to the specified step. 

 
Tool menu 

Data rearrangement 
Users can put the Parts Code Database list in alphabetic order by Parts code. 

 

If once the Parts Code Database list was sorted in alphabetic order, there is no way of putting it back to 
the original format. 

Property 
Clicking on Property in Tool menu to go to the Property window (Fig.124). For details, refer to Error list in Page 68. 

 
[Fig.124] Property 

Change Parts Code Database 
Users can search the specified information from the Parts Code Database list to replace by other one. 

Save (CSV/Text output) 
Users can output the Parts Code Database list into either CSV or Text format file. 

 
[Fig.125] Save (CSV/Text output) 

Delimiter is selected from Space, Comma, Semicolon or Tab.  
(When the CSF format is used, the delimiter to use is Comma only.) 
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Error list 

The error window (Fig.126) appears in the process of the data conversion if there was unregistered Parts code found in 
the Parts Code Database or some wrong information included there. The Error window indicates the number of Parts 
code detected as error. 

 
[Fig.126] Error window under data conversion 

Click on the Error List button to go to the Conversion Error List window (Fig.127) that indicates the Parts codes detected 
in the process of the data conversion. 

 
[Fig.127] Conversion Error list 

 
[ Parts ] 
This space indicates the letter strings substituted in “Parts” in the Takaya format data. 

[ Parts code ] 
This space indicates the letter strings substituted in “Parts code” in the Takaya format data. 

[ Error content ] 
This space indicates the reason for the errors. 
 

Error message Reason / Status 

Category of parts is not registered yet. 
This Parts code was newly added in the Parts Code Database as it was 
not registered yet. 

Attribute is unusual. 
This Parts code is for multi-terminal component but the Attribute (ex. 
Generation type, Base/Emitter) has not been configured yet. 

GND pin is unusual. 
The terminal number of IC’s GND and Register arrays’s common terminal 
has not been configured yet. 

 

The number of error 
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When unregistered Parts code was found in the process of the data conversion, it is added in the Parts Code Database 
automatically. (Refer to 000125 ~ 000139 in Fig.128) 
For other information (ex. Category of parts, Size, Pin) than Parts code added automatically, users should click the Edit 
button on the Error window to open the Property window to register them manually. 

 
[Fig.128] Parts Code Database list 

 

When the Takaya format data contains the Shape code, “Category of parts”, “Reference point”, “angle”, 
“Pin” and “Size” are automatically substituted if the same Shape code is already used in the Parts Code 
Database. 

 
[Fig.129] Property 

Use “Set the block copy source”, “Select the block copy destination” and “Implement the block copy” to 
copy and past the same content as the Parts Code Database to the Conversion Error list. 

 
Putting the mouse cursor on the Parts code on the Conversion Error list and clicking the Edit button, it displays the 
Property window which allows users to edit the database. 

    

(Without image file)                              (With image file) 
[Fig.130] Property 
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After edited the Property window, click the OK button. Then it launches new message window as shown below. 

 
[Fig.131] 

 
[Fig.132] 

Fig.131 appears when users edited the step which Parts Code Database has not been configured yet. If selected Yes, 
the TPS software performs the data conversion to generate the step data. If selected No, the TPS software performs the 
data conversion without generating the step data. 
 
Fig.132 appears when users modified the Parts Code Database which had been already configured. If selected Yes, the 
TPS software performs the data conversion to the step data which use the same Parts code again. (the step data will be 
generated again). If selected No, the TPS software saves the Parts code without generating the step data again. 
 
Approaching Data conversion error 
This section describes the procedures to approach the data conversion error. The items displayed on the Property 
window differ depending on the Category of parts specified by users. We will give you a couple of examples to explain 
the Property window. 
The first examples explain the procedure to approach the Data conversion error happens when no board image is used. 
For other examples that explain the procedure to specify the Parts size while using the board image, refer to Page 96. 
 
As mentioned earlier, click the OK button after edited the Property window, and it launches new message window as 
shown in Fig.131 or Fig.132. But they are beyond the scope of this section.  
 



- 71 - 

When Parts code is unregistered in the Parts Code Database 
< 2-terminal components > 

Parts  Parts code Error content 
R122 RK73B2BTTD103J Category of parts is not registered yet. 

The Parts code data list of “RK73B2BTTD103J” was newly added because it was not available there. But the 
Category of parts has not been specified yet. 

(How to approach this error) 
Place the mouse cursor on the line of R122. (The line changes to pink color) Click the Edit button, and it 
displays the Property window as shown in Fig.133 below. 

 
[Fig.133] Property in Parts Code Database (Resistors, Capacitors) 

( Value ) 
Assign the nominal value of R122 to the right edit box. When the Takaya format data contains “Value”, the 
value is substituted there automatically. The Value should be substituted by nominal value in case of the 
Resistors, the Capacitors and Inductors. 

( Element ) 
Select a suitable Element from the right pull-down menu. The Element is usually substituted automatically 
based on the capital letter of the Parts name. When the element is changed, users should select from 
Fig.134. 

Unregistered(*)  ICs (IC) Connectors (CN) 
Resistors (R) Photo couplers (PC) Fuses (F) 
Capacitors (C) Resistor arrays (RA) Switches (SW) 
Inductors (L) Volumes (VR) Filters (FL) 
Diodes (D) Crystals (X) FETs (FE) 
Transistors (Q) Jumpers (JW)   

[Fig.134] Element 

( Category of parts ) 
Clicking on the Category of parts column to select the suitable type from the graphic window (Fig.135). For 
R122, select “CHIP” and click the OK button. 

 
[Fig.135] Category of parts 
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( Angle ) 
As long as Standard angle (Environmental setting > Property) is already registered, usually it is unnecessary 
to specify it on the Property window any more. In rare cases, however this must be changed only if 0 (zero) 
degree of loaded component is other than Standard angle. (Let’s say, Standard angle is [A] in Fig.136 but the 
component is angled like [B]. In this case, users should specify 90 degrees.) 
Clicking on the Angle column to show which angle is registered at Standard angle (Environmental setting > 
Property). Users can change Angle suitably to 0 degrees, 90 degrees, 180 degrees or 270 degrees as 
needed. 

Pin #1

[A]  [B]

Pin #1

 
[Fig.136] Angle 

( Size ) 
Specify the size dimension of component shown on the right graphic display. 

 
[Fig.137] Size 

( Offset ) 
Specify Offset1,2 and Offset-I. 

 
[Fig.138] Offset 

 

Offset-2 appears only when the box “Use two normal offset value” (Environmental 
setting>Property) is selected. In addition, Offset-I appears only when the box “Use Nominal 
value conversion” (Environmental setting>Property) is selected. 

( Zone ) 
Users can configure High-fly / No-contact-zone as needed. (Refer to Page 37) 
 



- 73 - 

( Permission) 

 
[Fig.139] Permission 

If the box is selected, the probe access will be optimized in consideration of shape and thickness (height) of 
component. (Refer to Fig.140) 

Probe-1

Probe-2

Probe-3  

Probe-4  

Probe-1 Probe-3

Probe-2 Probe-4

[QFP]

Probe-1 Probe-3

Probe-2 Probe-4

  [Two-terminal components]
 

[Fig.140] 

After everything was configured, click the OK button to go back to the Conversion error list. Now the modified 
step changed to blue color. 
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< 3-terminal diodes > 
Parts  Parts code Error content 
D135 DAN217T146 Category of parts is not registered yet. 

The Parts code data list of “DAN217T146” was newly added because it was not available there. But the 
Category of parts has not been specified yet. 

(How to approach this error) 
Place the mouse cursor on the line of D135. (The line changes to pink color) Click the Edit button, and it 
displays the Property window as shown in Fig.141 below. 

 
[Fig.141] Property in Parts Code Database (3-terminal diode) 

( Element ) 
Select a suitable Element from the right pull-down menu. The Element is usually substituted automatically 
based on the capital letter of the Parts name. When the element is changed, users should select from 
Fig.134. 

( Category of parts ) 
Clicking on the Category of parts column to select the suitable type from the graphic window (Fig.135). For 
D135, select “Mini-module-3 (TYPE1)” and click the OK button. 

 
[Fig.142] 

( Reference point ) 
Select “Parts center”, “First pin” or “Arbitrary point” from the right pull-down menu. 

( Angle ) 
As long as Standard angle (Environmental setting > Property) is already registered, usually it is unnecessary 
to specify it on the Property window any more. In rare cases, however this must be changed only if 0 (zero) 
degree of loaded component is other than Standard angle. Users can change Angle suitably to 0 degrees, 90 
degrees, 180 degrees or 270 degrees as needed. 
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( Terminal type ) 
When the component has three terminals or more, it displays Fig.143. Specify the appropriate type and click 
the OK button. 

 
[Fig.143] Terminal type (Mini-module-3 (TYPE1)) 

( Size ) 
Specify the size dimensions “Size-C” and “Size-P” of component shown on the right graphic display. 

 
[Fig.144] Size (Mini-module-3 (TYPE1)) 

( Attribute ) 
Select necessary measurement from the right pull-down menu. 

      
[Fig.145] Attribute (Mini-module-3 (TYPE1)) 

Fig.145 shows that Diode measurement is made to Pin1-3 and Pin-3-2 and OP judge for Pin1-2.Users can 
select from 6 types of measurement; 

Meas. Measuring content 
* Unregistered 
R Resistor measurement 
C Capacitor measurement 
L Inductor measurement 
D Diode measurement 
OP OP (Open) judge 
SH SH (Short) judge 

 

 

Clicking the pin-to-pin button to generate the steps to test short between the neighboring 
pins automatically. (ex. P1-2,P2-3… ) In addition, clicking the pin-to-pin in all button to 
generate the steps to test between the pins in all combination automatically. 
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( Offset ) 
Specify Offset1,2 and Offset-I. 

 

Offset-2 appears only when the box “Use two normal offset value” (Environmental 
setting>Property) is selected. In addition, Offset-I appears only when the box “Use Nominal 
value conversion” (Environmental setting>Property) is selected. 

( Zone ) 
Users can configure High-fly / No-contact-zone as needed. (Refer to Page 37) 

( Permission) 

 
[Fig.146] Permission 

If the box is selected, the probe access will be optimized in consideration of shape and thickness (height) of 
component. (Refer to Fig.140) 

After everything was configured, click the OK button to go back to the Conversion error list. Now the modified 
step changed to blue color. 

    
 
 
< 3-terminal transistors > 

Parts  Parts code Error content 
Q111 DTC114EKA Category of parts is not registered yet. 

The Parts code data list of “DTC114EKA” was newly added because it was not available there. But the 
Category of parts has not been specified yet. 

(How to approach this error) 
Place the mouse cursor on the line of Q111. (The line changes to pink color) Click the Edit button, and it 
displays the Property window as shown in Fig.147 below. 

 
[Fig.147] Property in Parts Code Database (3-terminal transistor) 

( Element ) 
Select a suitable Element from the right pull-down menu. The Element is usually substituted automatically 
based on the capital letter of the Parts name. When the element is changed, users should select from 
Fig.134. 
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( Category of parts ) 
Clicking on the Category of parts column to select the suitable type from the graphic window (Fig.135). For 
Q111, select “Mini-module-3 (TYPE1)” and click the OK button. 

 
[Fig.148] 

( Reference point ) 
Select “Parts center”, “First pin” or “Arbitrary point” from the right pull-down menu. 

( Angle ) 
As long as Standard angle (Environmental setting > Property) is already registered, usually it is unnecessary 
to specify it on the Property window any more. In rare cases, however this must be changed only if 0 (zero) 
degree of loaded component is other than Standard angle. Users can change Angle suitably to 0 degrees, 90 
degrees, 180 degrees or 270 degrees as needed. 

( Terminal type ) 
When the component has three terminals or more, it displays Fig.149. Specify the appropriate type and click 
the OK button. 

 
[Fig.149] Terminal type (Mini-module-3 (TYPE1)) 

( Size ) 
Specify the size dimensions “Size-C” and “Size-P” of component shown on the right graphic display. 

 
[Fig.150] Size (Mini-module-3 (TYPE1)) 
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( Attribute ) 
Select each terminal name from the right pull-down menu. 

 
[Fig.151] Attribute (Mini-module-3 (TYPE1)) 

Click the checkbox “Also generate Digital transistor steps” in case of the Digital transistor. 

    
[Fig.152] Attribute (Mini-module-3 (TYPE1)) 

( Offset ) 
Specify Offset1,2 and Offset-I. 

 

Offset-2 appears only when the box “Use two normal offset value” (Environmental 
setting>Property) is selected. In addition, Offset-I appears only when the box “Use Nominal 
value conversion” (Environmental setting>Property) is selected. 

( Zone ) 
Users can configure High-fly / No-contact-zone as needed. (Refer to Page 37) 

( Permission) 

 
[Fig.153] Permission 

If the box is selected, the probe access will be optimized in consideration of shape and thickness (height) of 
component. (Refer to Fig.140) 

After everything was configured, click the OK button to go back to the Conversion error list. Now the modified 
step changed to blue color. 
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< Transistors (4 or more terminals) > 
Parts  Parts code Error content 
Q200 XN4401 Category of parts is not registered yet. 

The Parts code data list of “XN4401” was newly added because it was not available there. But the Category 
of parts has not been specified yet. 

(How to approach this error) 
Place the mouse cursor on the line of Q200. (The line changes to pink color) Click the Edit button, and it 
displays the Property window as shown in Fig.154 below. 

 
[Fig.154] Property in Parts Code Database (Transistor) 

( Element ) 
Select a suitable Element from the right pull-down menu. The Element is usually substituted automatically 
based on the capital letter of the Parts name. When the element is changed, users should select from 
Fig.134. 

( Category of parts ) 
Clicking on the Category of parts column to select the suitable type from the graphic window (Fig.135). Q200 
has 6 terminals, but select “SOP (Standard)” and click the OK button. (If there isn’t exactly the same type in 
Fig.135, users should select the closest type) 

 
[Fig.155] Category of parts (Transistor) 

( Reference point ) 
Select “Parts center”, “First pin” or “Arbitrary point” from the right pull-down menu. 

( Angle ) 
As long as Standard angle (Environmental setting > Property) is already registered, usually it is unnecessary 
to specify it on the Property window any more. In rare cases, however this must be changed only if 0 (zero) 
degree of loaded component is other than Standard angle. Users can change Angle suitably to 0 degrees, 90 
degrees, 180 degrees or 270 degrees as needed. 
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( Pin ) 
Specify the number of terminal. 

( Size ) 
Specify the size dimensions “Size-B”, “Size-C” and “Size-P” of component shown on the right graphic display. 
If the Size-B was specified, the same size is substituted to “Size-C” automatically. 

 
[Fig.156] Size (SOP (Standard)) 

( Attribute ) 
Select each terminal name from the right pull-down menu. As Q222 consists of two transistors, the terminal 
name will be shown in Fig.157. 
Click the checkbox “Also generate Digital transistor steps” in case of the Digital transistor. 

      
[Fig.157] Attribute (SOP (Standard) 

( Offset ) 
Specify Offset1,2 and Offset-I. 

 

Offset-2 appears only when the box “Use two normal offset value” (Environmental 
setting>Property) is selected. In addition, Offset-I appears only when the box “Use Nominal 
value conversion” (Environmental setting>Property) is selected. 

( Zone ) 
Users can configure High-fly / No-contact-zone as needed. (Refer to Page 37) 

( Permission) 

 
[Fig.158] Permission 

If the box is selected, the probe access will be optimized in consideration of shape and thickness (height) of 
component. (Refer to Fig.140) 

After everything was configured, click the OK button to go back to the Conversion error list. Now the modified 
step changed to blue color. 
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Supplemental remarks for Transistors and FETs with special internal structures 
 
(Ex.1) 
When E1(Emitter) of Tr1 and B2(Base) of Tr2 are common, user should specify “E1” and “B2” as shown below. 

1:B1
2:E1,B2
3:E2
4:C2
5:C1

5

4

1

2

3

 Tr1

Tr2

   
[Fig.159] 

 
(Ex.2) 
In case of such FET which consists of Terminal 1, 2, 3 as Source in common, Terminal 4 as Gate and Terminal 5,6,7,8 
as Drain in common, user should specify like below; 

1,2,3     : Source
4           : Gate
5,6,7,8  : Drain

1     2     3    4

8     7     6    5

    
[Fig.160] 
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< IC (SOP) > 
Parts  Parts code Error content 
IC137 SN74ABT541 Category of parts is not registered yet. 

The Parts code data list of “SN74ABT541” was newly added because it was not available there. But the 
Category of parts has not been specified yet. 

(How to approach this error) 
Place the mouse cursor on the line of IC137. (The line changes to pink color) Click the Edit button, and it 
displays the Property window as shown in Fig.161 below. 

 
[Fig.161] Property in Parts Code Database (IC) 

( Element ) 
Select a suitable Element from the right pull-down menu. The Element is usually substituted automatically 
based on the capital letter of the Parts name. When the element is changed, users should select from 
Fig.134. 

( Category of parts ) 
Clicking on the Category of parts column to select the suitable type from the graphic window (Fig.135). IC137 
is SOP, so select “SOP (Standard)” and click the OK button. 

 
[Fig.162] Category of parts (IC) 

( Reference point ) 
Select “Parts center”, “First pin” or “Arbitrary point” from the right pull-down menu. 

( Angle ) 
As long as Standard angle (Environmental setting > Property) is already registered, usually it is unnecessary 
to specify it on the Property window any more. In rare cases, however this must be changed only if 0 (zero) 
degree of loaded component is other than Standard angle. Users can change Angle suitably to 0 degrees, 90 
degrees, 180 degrees or 270 degrees as needed. 

( Pin ) 
Specify the number of terminal. 
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( Size ) 
Specify the size dimensions “Size-B”, “Size-C” and “Size-P” of component shown on the right graphic display. 
If the Size-B was specified, the same size is substituted to “Size-C” automatically. 

 
[Fig.163] Size (SOP (Standard)) 

( Attribute ) 
Users should specify “Generation” and “Ground pin”. 

 
[Fig.164] Attribute (IC) 

Generation must be specified by either “Pin to pin & pin to ground”, “Only pin to pin” or “Only pin to ground”. 
Ground pin must be specified by the GND pin number of the IC. 

In case that the checkbox “Also generate IC open steps” is selected, users should specify the IC package 
size in order to generate the IC open test steps. (Refer to Fig.165) 

 
[Fig.165] 

( Offset ) 
Specify Offset1,2 and Offset-I. 

 

Offset-2 appears only when the box “Use two normal offset value” (Environmental 
setting>Property) is selected. In addition, Offset-I appears only when the box “Use Nominal 
value conversion” (Environmental setting>Property) is selected. 

( Zone ) 
Users can configure High-fly / No-contact-zone as needed. (Refer to Page 37) 

( Permission) 

 
[Fig.166] Permission 

If the box is selected, the probe access will be optimized in consideration of shape and thickness (height) of 
component. (Refer to Fig.140) 

After everything was configured, click the OK button to go back to the Conversion error list. Now the modified 
step changed to blue color. 
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< IC (QFP) > 
Parts Parts code Error content 
IC100 TFP401P Category of parts is not registered yet. 

The Parts code data list of “TFP401P” was newly added because it was not available there. But the Category 
of parts has not been specified yet. 

(How to approach this error) 
Place the mouse cursor on the line of IC100. (The line changes to pink color) Click the Edit button, and it 
displays the Property window as shown in Fig.167 below. 

 
[Fig.167] Property in Parts Code Database (IC) 

( Element ) 
Select a suitable Element from the right pull-down menu. The Element is usually substituted automatically 
based on the capital letter of the Parts name. When the element is changed, users should select from 
Fig.134. 

( Category of parts ) 
Clicking on the Category of parts column to select the suitable type from the graphic window (Fig.135). IC100 
is QFP, so select “QFP (Standard)” and click the OK button. 

 
[Fig.168] Category of parts (IC) 

( Reference point ) 
Select “Parts center”, “First pin” or “Arbitrary point” from the right pull-down menu. 

( Angle ) 
As long as Standard angle (Environmental setting > Property) is already registered, usually it is unnecessary 
to specify it on the Property window any more. In rare cases, however this must be changed only if 0 (zero) 
degree of loaded component is other than Standard angle. Users can change Angle suitably to 0 degrees, 
90 degrees, 180 degrees or 270 degrees as needed. 
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( Pin ) 
Specify the number of terminal. 

( Size ) 
Specify the size dimensions of component shown on the right graphic display. 
For QFP (Standard), specify “Pin-N1”, “Pin-N2”, “Size-B”, “Size-C1”, “Size-P1”, “Size-C2” and “Size-P2”. 
If the Size-B was specified, the same size is substituted to “Size-C1” and “Size-C2” automatically. 

 
[Fig.169] Size (QFP (Standard)) 

( Attribute ) 
Users should specify “Generation” and “Ground pin”. 

 
[Fig.170] Attribute (IC) 

Generation must be specified by either “Pin to pin & pin to ground”, “Only pin to pin” or “Only pin to ground”. 
Ground pin must be specified by the GND pin number of the IC. 

In case that the checkbox “Also generate IC open steps” is selected, users should specify the IC package size 
in order to generate the IC open test steps. (Refer to Fig.171) 

 
[Fig.171] 

( Offset ) 
Specify Offset1,2 and Offset-I. 

 

Offset-2 appears only when the box “Use two normal offset value” (Environmental 
setting>Property) is selected. In addition, Offset-I appears only when the box “Use Nominal 
value conversion” (Environmental setting>Property) is selected. 

( Zone ) 
Users can configure High-fly / No-contact-zone as needed. (Refer to Page 37) 

( Permission) 

 
[Fig.172] Permission 

If the box is selected, the probe access will be optimized in consideration of shape and thickness (height) of 
component. (Refer to Fig.140) 

After everything was configured, click the OK button to go back to the Conversion error list. Now the modified 
step changed to blue color. 
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When Attribute is unusual 
< Transistors > 

Parts  Parts code Error content 
Q119 DTA114EKA Attribute is unusual. 

Attribute in the Parts code data list of “DTA114EKA” has been unregistered or set wrong. 

(How to approach this error) 
Place the mouse cursor on the line of Q119. (The line changes to pink color) Click the Edit button, and it 
displays the Property window as shown in Fig.173 below. 

 
[Fig.173] Attribute is unusual 

( Attribute ) 
Specify Attribute properly if it has been unregistered as shown in Fig.173. 
In addition, correct Attribute when it has been set wrong as shown in the left window of Fig.174. 

    
(Wrong)                        (Correct) 

[Fig.174] Attribute is unusual 
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When GND pin is unusual 
Parts  Parts code Error content 
IC129 TFP401P GNP pin is unusual. 

Ground pin of Attribute in the Parts code data list of “TFP401P” has been unregistered or set wrong. 

(How to approach this error) 
Place the mouse cursor on the line of IC129. (The line changes to pink color) Click the Edit button, and it 
displays the Property window as shown in Fig.175 below. 

 
[Fig.175] Attribute is unusual 

( Attribute ) 
Specify Ground pin properly if it has been unregistered as shown in Fig.175. 
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Approaching Data conversion error for other components 
Listed below are a couple of examples for your better understanding the way to approach other data conversion error. 
 
Resistor network (SMD) 
 

   
[Fig.176] Resistor network (SMD) 

 
( Category of parts ) 
Clicking on the Category of parts column to select “SOP (Standard)”. 

 
[Fig.177] Resistor network (SMD) 

 
( Element ) 
Select “Resistor arrays (RA)” from the right pull-down menu. 
 
( Attribute ) 
Select necessary measurement from the right pull-down menu. 

 
[Fig.178] Attribute (Resistor arrays) 
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Type of Attribute Measurement 

Select pin number Users can specify combination of terminal numbers directly in the 
column and select necessary measurement from the right pull-down 
menu. (Refer to Page 76) 

 

Facing pins & pin to pin “Facing pin” means combination of 1-8P, 2-7P, 3-6P and 4-5P in 
Fig.176 to measure each resistance. 
“Pin to pin” means combination of P1-2, P2-3, P3-4, P4-5, P5-6, P6-7 
and P7-8 to perform Open check. 

Pin to pin & pin to common Pin to pin is to perform Open check in each neighboring pins. And 
Pin to common is to measure each pin against common pin. The 
common pin is configurable by users. 

 

Only facing pin “Facing pin” means combination of 1-8P, 2-7P, 3-6P and 4-5P in 
Fig.176 to measure each resistance. 

Only pin to pin Pin to pin is to perform Open check in each neighboring pins. 
Only pin to common Pin to common is to measure each pin against common pin. 

    
 
 
Specially-shaped resistor network (SMD) 

Let’s see a case that common terminals are at both sides like Fig.178 below. 

 
[Fig.179] Specially-shaped resistor network 

( Category of parts ) 
Clicking on the Category of parts column to select “Special-parts”. 
The terminal marked in red is Pin #1. 

 
[Fig.180] Specially-shaped resistor network 

( Element ) 
Select “Resistor arrays (RA)” from the right pull-down menu. 
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( Attribute ) 
Select “Only pin to common” from the right pull-down menu. 

 
[Fig.181] Specially-shaped resistor network 

    
 
Specially-shaped IC (SMD) 

(Ex.1) 
Let’s see IC where a metal frame is in the middle like Fig.182 below. 

1 10

1120

5 6

1516

 
[Fig.182] Specially-shaped IC 

( Category of parts ) 
Clicking on the Category of parts column to select “SOP (Standard)”. 

 
[Fig.183] Specially-shaped IC 

( Pin ) 
Specify the number of terminal. (ex. 20) 

( Size ) 
Specify “Size-B” which is a distance between pin and pin. 
If the Size-B was specified, the same size is substituted to “Size-C” automatically. But it is wrong, so users 
should enter correct size for the Size-C manually again. 

Clicking on “Shape” tab to open Fig.184 below. 

 
[Fig.184] Specially-shaped IC 
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(Ex.2) 
Let’s see IC where two terminals are at both side like Fig.185 below.  

 

1 6

7

8

914

15

16

 
[Fig.185] Specially-shaped IC 

( Category of parts ) 
Clicking on the Category of parts column to select “QFP (Standard)”. 

( Size ) 
Specify “6” in Pin-N1 and “2” in Pin-N2. 
Specify “Size-B” which is a distance between pin and pin. If the Size-B was specified, the same size is 
substituted to “Size-C1” and “Size-C2” automatically. But the Size-C2 is set wrong, so users should enter 
correct size manually again. 

 
[Fig.186] Specially-shaped IC 

Clicking on “Shape” tab to open Fig.187 below. 

 
[Fig.187] Specially-shaped IC 
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THT components 
Let’s see a connector that has pins in line like Fig.188 below. 

 
[Fig.188] THT component 

( Category of parts ) 
Clicking on the Category of parts column to select “THT-1-line”. 

    
[Fig.189] SMD/THT 

( Reference point ) 
Select the reference point of the connector from the right pull-down menu. (ex. “First pin”) 

( Pin ) 
Specify the number of terminal. (ex. “4”) 

( Size ) 
Specify “Size-B” which is a distance between pin and pin. If the Size-B was specified, the same size is 
substituted to “Size-C” automatically. Click on the OK button. 

 
[Fig.190] THT-1-line 

    
 

 
 

“THT”  tab 
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Irregularly-shaped components 
When there is no similar sample in Category of parts, use “Irregular” to generate the step data. 

[ SMD components ] 
Let’s see a SMD component which terminals are not arranged evenly like Fig.191 below. 

1

5

 
[Fig.191] Irregularly-shaped component (SMD) 

( Category of parts ) 
Clicking on the Category of parts column to select “Irregular (SMD)”. 

 
[Fig.192] Irregularly-shaped component (SMD) 

( Reference point ) 
Select the reference point of the connector from the right pull-down menu. (ex. “Arbitrary point”) 

( Pin ) 
Specify the number of terminal. (ex. “5”) 

( Size ) 
Users should specify the distance from the reference point to each terminal, assuming that the component is 
placed on the board with 0 (zero) degree. Specifically, it should be [B] in the example of Fig.193, even if 
actually the component is placed on the board according to the specified Angle (90 degrees 
counterclockwise) in the Takaya format data. 

1 5
[B][A]

1

5

Actual Angle 0 degree
 

[Fig.193] Irregularly-shaped component (SMD) 
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When the distance from the reference point to each terminal is as shown Fig.194, users should specify just 
like Fig.195. 

1 5

2mm 2mm 2mm 1.5mm5mm

Reference point

 
[Fig.194] Irregularly-shaped component (SMD) 

 
[Fig.195] Irregularly-shaped component (SMD) 

 

When Reference point is specified to First pin, the distance must be from the first pin to 
each terminal. 

 
 
 
[ THT components ] 
Let’s see a THT component which terminals are not arranged evenly like Fig.196 below. 

1

5

 
[Fig.196] Irregularly-shaped component (THT) 

( Category of parts ) 
Clicking on the Category of parts column to select “Irregular (THT)”. 

 
[Fig.197] Irregularly-shaped component (THT) 

( Reference point ) 
Select the reference point of the connector from the right pull-down menu. (ex. “Arbitrary point”) 
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( Pin ) 
Specify the number of terminal. (ex. “5”) 
 

( Size ) 
Users should specify the distance from the reference point to each terminal, assuming that the component is 
placed on the board with 0 (zero) degree. Specifically, it should be [B] in the example of Fig.198, even if 
actually the component is placed on the board according to the specified Angle (90 degrees 
counterclockwise) in the Takaya format data. 

15

[B][A]

1

5

Actual Angle 0 degree  
[Fig.198] Irregularly-shaped component (THT) 

When the distance from the reference point to each terminal is as shown Fig.199, users should specify just 
like Fig.200. 

15

6mm

1.0  2.5 2.5

Terminal pitch

 2.5 3.2 

Reference point

 
[Fig.199] Irregularly-shaped component (THT) 

 
[Fig.200] Irregularly-shaped component (THT) 
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Image-based correction of Data conversion error 

On the Property window in Conversion Error list, users can configure Size, Angle and High-fly / No-contact-zone through 
the use of image data (IMG file) taken by Real map function or image data (BMP, JPG file) scanned in a scanner and 
taken by a digital camera. 
 
2-terminal components 

Place the mouse cursor on the line of 2-terminal component “RK73H1JTD1KRF” and click the Edit button to 
display the Property window (Fig.202). 

 
[Fig.201] Conversion Error list 

( Category of parts ) 
Clicking on the Category of parts column to select “CHIP”.  

    
[Fig.202] 

( Reference point ) 
Select the reference point of the connector from the right pull-down menu. (ex. “Parts center”)  

( Size ) 
Click “Graphic” tab at the right screen, and it displays Fig.203. 

 
[Fig.203] 
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Use the Magnification button on the bottom to scale up the image to the proper level. Then drag a red box 
around the component with the mouse. As the result, it displays the size information as shown in Fig.204 
below, so users can study the size of component is “1.63mm”. 

 
[Fig.204] 

After entered the size in the Size-P box, the two contact points (red & green marker) are displayed with the 
specified distance. 

 
[Fig.205] 

( Angle ) 
As long as Standard angle (Environmental setting > Property) is already registered, usually it is unnecessary 
to specify it on the Property window any more. In rare cases, however this must be changed only if 0 (zero) 
degree of loaded component is other than Standard angle. Use the Angle button to turn the contact points to 
meet the graphic image of component. 

 
[Fig.206] 

After specified Offset, click the OK button, and it moves back to the Conversion Error list (Fig.201). 
 

 
 

Angle button 
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Multi-terminal components 
Hereinafter, the modification steps will be concretely described with IC as a sample. 
Click the Edit button on the Conversion Error list to display the Property window (Fig.207). 

( Category of parts ) 
Clicking on the Category of parts column to select “SOP (Standard)”. 

    
[Fig.207] 

( Reference point ) 
Select the reference point of the connector from the right pull-down menu. (ex. “Parts center”) 

( Pin ) 
Specify the number of terminal. 

( Size ) 
Click “Graphic” tab at the right screen, and it displays Fig.208. 

 
[Fig.208] 

[Size-B] 
Use the Magnification button on the bottom scale up the image to the proper level. Then drag a red box 
around the area that indicates the distance between two terminals (=Size-B) with the mouse. (Refer to 
Fig.209) As the result, it displays the size information (ex. X： 1.266mm,Y:0.888mm), so users can study 
Size-B is “1.27mm”. 

 
[Fig.209] 
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[Size-P] 
Drag a red box around the area that indicates Size-P with the mouse. (Refer to Fig.210) As the result, it 
displays the size information (ex. X： 4,404mm,Y:7.924mm), so users can study Size-B is “7.93mm”. 

 
[Fig.210] 

After configured the Size boxes, the contact points (red & green marker) are displayed with the specified 
distance. The red point means First pin. 

 
[Fig.211] 

( Angle ) 
As long as Standard angle (Environmental setting > Property) is already registered, usually it is unnecessary 
to specify it on the Property window any more. In rare cases, however this must be changed only if 0 (zero) 
degree of loaded component is other than Standard angle. Use the Angle button to turn the contact points to 
meet the graphic image of component. 

 
[Fig.212] 

( Attribute ) 
Users should specify “Generation” and “Ground pin”. 

 
[Fig.213] 

Generation must be specified by either “Pin to pin & pin to ground”, “Only pin to pin” or “Only pin to ground”. 
Ground pin must be specified by the GND pin number of the IC. 

 

Angle button 
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In case that the checkbox “Also generate IC open steps” is selected, users should specify the IC package 
size in order to generate the IC open test steps. (Refer to Fig.214) 

 
[Fig.214] 

The IC package size is automatically substituted by simply dragging a red box around the IC with the mouse 
as shown in Fig.215 below. At the same time, the XY coordinates of the sensor probe for the IC open test will 
be automatically generated when the checkbox “Also generate IC open steps” is selected. 

 
[Fig.215] 

( Offset ) 
Specify Offset1,2 while checking the contact points on the right graphic window. 

 

Offset-2 appears only when the box “Use two normal offset value” (Environmental 
setting>Property) is selected. In addition, Offset-I appears only when the box “Use Nominal 
value conversion” (Environmental setting>Property) is selected. 

( Zone ) 
Users can configure High-fly / No-contact-zone as needed. (Refer to Page 37) 

( Permission) 

 
[Fig.216] Permission 

If the box is selected, the probe access will be optimized in consideration of shape and thickness (height) of 
component. (Refer to Fig.140) click the OK button to go back to the Conversion error list. 

 

The right graphic window is designed to display the component at the center just like the left 
window of Fig.217. Use the left mouse button to drag the image while depressing the 
Space key on the keyboard when the image should be moved back and forth and around. 

    
[Fig.217] 
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THT components (DIP) 
2-Terminal components 

Click the Edit button on the Conversion Error list to display the Property window (Fig.218). 

 
[Fig.218] 

( Category of parts ) 
Clicking on the Category of parts column to select “THT-2-terminals” from the THT tab menu and click the OK 
button. 

 
[Fig.219] 

The display moves back to the Property window. 
When the Category of parts is specified to THT components, it displays information on the Dip side. 

 
[Fig.220] 

( Reference point ) 
Select the reference point of the connector from the right pull-down menu. (ex. “Parts center”) 
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[Size-P] 
Use the Magnification button on the bottom to scale up the image to the proper level. Then drag a red box 
around the area where indicates the distance between the two terminals of component with the mouse. As 
the result, it displays the size information as shown in Fig.221 below, so users can study the size of 
component is “10.4mm”. 

 
[Fig.221] 

After entered the size in the Size-P box, the two contact points (red & green marker) are displayed with the 
specified distance. 

 
[Fig.222] 

( Angle ) 
As long as Standard angle (Environmental setting > Property) is already registered, usually it is unnecessary 
to specify it on the Property window any more. In rare cases, however this must be changed only if 0 (zero) 
degree of loaded component is other than Standard angle. Use the Angle button to turn the contact points to 
meet the graphic image of component. 

Click the OK button to go back to the Conversion error list. 
 



- 103 - 

Multi-terminal components 
Click the Edit button on the Conversion Error list to display the Property window (Fig.223). 

 
[Fig.223] 

( Category of parts ) 
Clicking on the Category of parts column to select “THT-1-line” from the THT tab menu and click the OK 
button. 

 
[Fig.224] 

The display moves back to the Property window. 
When the Category of parts is specified to THT components, it displays information on the Dip side. 

 
[Fig.225] 

( Reference point ) 
Select the reference point of the connector from the right pull-down menu. (ex. “Parts center”) 

( Angle ) 
As long as Standard angle (Environmental setting > Property) is already registered, usually it is unnecessary 
to specify it on the Property window any more. In rare cases, however this must be changed only if 0 (zero) 
degree of loaded component is other than Standard angle. Use the Angle button to turn the contact points to 
meet the graphic image of component. 
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( Pin ) 
Specify the number of terminal. (ex. 4”) 

( Size ) 
At first users should specify “Size-B”. Use the Magnification button on the bottom scale up the image to the 
proper level. Then drag a red box around the area that indicates the distance between two terminals 
(=Size-B) with the mouse. (Refer to Fig.226) As the result, it displays the size information (ex. Y:2,566mm), so 
users can study Size-B is “2.54mm”. 

 
[Fig.226] 

After the Size-B was specified, “Size-C” will be automatically substituted by the correct value. 

 
[Fig.227] 

After entered the size in the Size boxes, the contact points (red & green marker) are displayed with the 
specified distance. 

 
[Fig.228] 

( Abolished pin) 
Refer to the next page. 

( Zone ) 
Users can configure High-fly / No-contact-zone as needed. (Refer to Page 37) 

Click the OK button to go back to the Conversion error list. 
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Abolished pin 
Use “Abolished pin” when there are pins missing from the component as shown in Fig.229. 

   

1

2

3

4

 
[Fig.229] Abolished pin 

When there are missing pins in the middle, specify the pin numbers. As the result, the coordinates are masked so that the 
test program of using the pin numbers won’t be generated. 

 
[Fig.230] Abolished pin 

In general, the components where some pins are missing in the middle are classified into two types, Type-A and Type-B. 
Be sure to select either one of the checkboxes on Fig.230 to specify which type it is. 
 
[Type-A] 
This is the cases that the pin number are also missing in middle as shown in Fig.231 below. The Pin should be specified 
by the number of pins used on the component. (ex. “4” in case of Fig.231) 

1

2

4

 
[Fig.231] Type-A 

Abolished pin 



- 106 - 

[Type-B] 
This is the cases that the pin numbers are not missing as shown in the left drawing of Fig.232 below. But the Pin should 
be specified in the same manner as Type-A. (ex. “4” in case of Fig.232) In addition, the Abolished pin should be specified 
based on the right figure of Fig.232 (ex. “3” in case of Fig.232) 

1

2

3

1

2

4

 Real pin arrangement Pin arrangement to assume 
when specifying Abolished pin  

[Fig.232] Type-B 

 

The Abolished pin is displayed only when Category of parts is selected to other than “Mini-module-3(TYPE-1)”, 
“Mini-module-3(TYPE-2)”, “Mini-module-4(TYPE-1)”, “Mini-module-4(TYPE-2)”, “Mini-module-5(TYPE-1)”, 
“Mini-module-5(TYPE-2)”, “THT-3-terminals(TYPE-1)”, “THT-4-terminals(TYPE-1)”, “THT-4-terminals(TYPE-2)”, 
“THT-5-terminals(TYPE-1)”, “THT-5-terminals(TYPE-2)”, “Irregular(SMD)” and “Irregular(THT)”. 

 
 
XY Coordinates Input 
When the data generation based on the Parts Code Database wasn’t accomplished, users should input XY coordinates 
with Digitizer function based data programming mode. For details, refer to “XY Coordinates Input” in Page 29. 
 
 

Optimization 

Optimization in Tool menu consists of Sorting function and Combination measurement set function which are useful in 
reducing the test time to test the program. 

Data mode setting 

Refer to the User’s guide for the APT-9411 Series. 

Test mode setting 

Refer to the User’s guide for the APT-9411 Series. 

Data save 

Refer to the User’s guide for the APT-9411 Series. 

 

When the data save is performed, the information on the environmental setting and the Parts code data 
is also saved at the same time. At the time of loading the program in the TPS software again, the Parts 
code data saved inside the program will be compared with the one stored in the Parts Code Database. If 
there are some differences (ex. Size) found during the loading even in spite of the same Parts code 
data, the Parts code data will be displayed. (For details, refer to the next page) In case of new Parts 
code data, it will be saved in the Parts Code Database automatically. 
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Menu explanation 
This chapter explains features available in the Menu bar. Because most features are common to the software of the 
APT-9411 Series, only the features specific to the TPS software are discussed in this chapter. 
 

File 

Click File in the Menu bar to list the File menu on the display. Use the File menu to either load or save the test program. 
 
New 
This enables to make a new test program. 

 

When there is a test program users are still editing, be sure to save it in the disk before performing this 
function. 

 
Open 
This enables to load a test program saved in the disk. (Refer to Fig.233) 

 
 

 
[Fig.233] File > Open 

 
Choose any of [ 91W ] [ 90W ] [ 80W ] [ 80D ] [ 20D ] [ CAD ] [ BAS ] [ CA9 ] [ PIN ] button at the bottom on the dialog box, 
and it will display the data file list as indicated below. 
 
[ 91W ] Test program file for the APT-9411 Series (Extension “.SWX”) 

[ 90W ] Test program file for the APT-9400/APT-9401 Series (Extension “.SW9” “.SW91” “.SW92”) 

[ 80W ] Test program file for the APT-8300/APT-8400 Series (Windows) (Extension “.SW8” “.SW81”) 

[ 80D ] Test program file for the APT-8300/APT-8400 Series (MS-DOS) (Extension “.SD8”) 

[ 20D ] Test program file for the APT-2100/APT-2200 Series (MS-DOS) (Extension “.SDT”) 

[ CAD ] CAD data file configured to Takaya format (Extension “.CA8” “.CA9” “.CW8” “.CW9”) 

[ BAS ] Basic data file configured to Takaya format (Extension “.BA8” “.BW8” “.BW9”) 

[ CA9 ] Extension CAD data file configured to Takaya format (Extension “.CA9”) 

[ PIN ] Pin coordinates data for Point system (Extension “.PIN”) 
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In cases of loading the test program saved by the TPS-4 software 
 

 

The XY coordinates in a test program for the APT-9411 Series is editable on the TPS software. But the 
XY coordinates for a fine-pitch leads may not be editable properly on the TPS software depending on 
what kind of image is used for. In this case, users should rather use the APT-9411 Series to edit them. In 
addition, the change of the measuring conditions (ex. Measuring mode, Measuring time, Reference 
value, so on) should be performed on the APT-9411 Series. 

 
When the TPS software saves a test program in SWX format for the APT-9411 Series, the information on the 
environmental setting and the Parts code data is also saved in it at the same time. At the time of loading the SWX 
program in the TPS software, the information on the environmental setting and the Parts code data saved inside will be 
loaded as well. 
 
The procedure of loading the SWX program in the TPS software differs depending on the environmental settings (Master 
mode, Standard angle, Parts code data list) managed by the SWX program and the TPS software. Especially, caution 
should be exercised in the selection of the box “Maintain more than one environmental setting for convert” on File/Folder 
menu in Master mode. (Refer to Table-1 below). 
 

SWX program TPS Software  

When the box is not selected. Regardless of selection of the box. Refer to CASE 1 in Page 109. 

When the box is selected. When the box is not selected. Refer to CASE 2 in Page 111 

When the box is selected. When the box is selected. Refer to CASE 3 in Page 113 

[Table-1] 
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 CASE 1  
In cases when the SWX program saved by the TPS software which “Maintain more than one environmental 
setting for convert”  box on File/Folder menu in Master mode was not selected is loaded into the TPS software; 
 
Usually, the information on the environmental setting and the Parts code data is saved in the Projectdata folder named 
“TAKAYA”. 

 

       
[Flowchart 1-1] 

 
(Remark 1) 
In Flowchart 1-2, if users create other Projectdata folder than “TAKAYA”, the box “Maintain more than one environmental 
setting for convert” on File/Folder menu in Master mode will be automatically selected by loading the SWX program. 
 

Loading of SWX program 

Completion of loading SWX program 

 Exist   Not exist  

 Matched   Mismatched 

Compare the Parts code data of the SWX program to the Projectdata 

holder named “TAKAYA” to check if there is the same Parts code. 

Matched? 

 Yes   No   Yes   No  

Adding new  

Parts code data list 

Not adding new  

Parts code data list 

Move to Flowchart 1-2 

(See Remark 1) 

It displays Fig.230. 

Compare Standard angle of the SWX program to 

the Projectdata folder named “TAKAYA”. 
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[Flowchart 1-2] 

Completion of loading SWX program 

 Mismatched  

 Yes   No  

 
“TVX09PB” is the Projectdata folder currently used by the TPS software. This 

is an execution confirmation message to ask if users want to create a new 

Projectdata folder. 

The TPS software opens the Select Environmental 
Setting window (Fig.229). If users select the existing 
Project data folder, the new Parts code data 
included in the SWX program will be added on 
there. When the same Parts code data including 
differences was found, it displays Fig.230. 

The information on the environmental setting and 
the new Parts code data are saved. 

 

 Yes   No  

 ←  Continued from previous page 

The TPS software opens the 
Select Environmental Setting 
window (Fig.229). Select the 
Projectdata holder to save. 

The information on the 
environmental setting and the 
new Parts code data are saved 
in the folder. 

Move to (A) in Flowchart 2-1 

Standard angle saved in the 
SWX program is overwritten in 
the existing Projectdata folder. 
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 CASE 2  
In cases when the SWX program saved by the TPS software which maintains more than one Projectdata folder 
is loaded into the TPS software which “Maintain more than one environmental setting for convert”  box on 
File/Folder menu in Master mode is not selected; 

 
[Flowchart 2-1] 

 
(Remark 2) 
In Flowchart 2-2, the box “Maintain more than one environmental setting for convert” on File/Folder menu in Master mode 
can be automatically selected by loading the SWX program. 
 

Loading of SWX program 

 
“TVX09PB” is the Projectdata folder used when the SWX 

program was generated on the TPS software.  

 Yes   No  

Completion of loading SWX program 

 Yes   No  

 Yes   No  

 Exist   Not exist  

It displays Fig.230. 

 Yes   No  

Matched? 

New Projectdata folder named “TVX09PB” is added.  

The information on the environmental setting and the 

new Parts code data are saved in the folder. 

(A) 

Comparison of Standard angle 

 Matched   Mismatched 

Move to Flowchart 1-2 

Move to Flowchart 2-2 

(See Remark 2) 

 

The Parts code data is added to 

the Projectdata folder named 

“TVX09PB”. 

The Parts code data is not 

added to the Projectdata folder 

named “TVX09PB”. 

Compare the Parts code data 

list to check if there is the same 

Parts code. 

Is there the same Projectdata folder named “TVX09PB”? 
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[Flowchart 2-2] 

 
(Remark 3) 
1)  New Parts code data included in the SWX program is added to the existing Parts code data list. The Standard 

angle of the Parts code data included in the SWX program is replaced by the existing Standard angle. Therefore, 
when Parts code data which has different Standard angle is added, unintended XY coordinates can be created. 
Pay much attention when Parts code data which has different Standard angle is added. 

2)  If there is the Part code with the same name when the Parts code data is added, it displays Fig.235. 
 

It displays Fig.230. 

Completion of loading SWX program 

 Exist   Not exist  

Comparison of Standard angle 

 Matched   Mismatched  

Compare the Parts code saved in the SWX 

program to the existing Parts code data list 

to check if there is the same Parts code. 

Matched? 

 Yes   No   Yes   No  

Adding new Parts code data 

on the list. (See Remark 3) 

Not adding new Parts 
code data on the list. 

Move to Flowchart 1-2 

 

 ←  Continued from previous page 
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 CASE 3  
In cases when the SWX program saved by the TPS software which maintains more than one Project folder is 
loaded into the TPS software which “Maintain more than one environmental setting for convert”  box on 
File/Folder menu in Master mode is selected; 

 

 
[Flowchart 3-1] 

 

Loading of SWX program 

Is there Projectdata folder with the same name? 

 Exist   Not exist 

Completion of loading SWX program 

 Exist   Not exist  

It displays Fig.230. 

Comparison of Standard angle 

 Matched   Mismatched  

Compare the Parts code saved in the SWX program to the existing 
Parts code data list to check if there is the same Parts code. 

Matched? 

 Yes   No   Yes   No  

Move to Flowchart 1-2 

Move to Flowchart 3-2 

Adding new Parts 

code data on the list 

Not adding new Parts 

code data on the list. 
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[Flowchart 3-2] 

 
(Remark 4) 
1)  At the time of displaying Fig.234, the TPS software stops loading the information on the environmental setting and 

the new Parts code data included in the SWX program. In this case, the environmental setting and the Parts code 
data list in the existing Parts Code Database is used. 

2)  As for the folder operation method, refer to Projectdata folder in Page 27. 

 
[Fig.234] Select Environmental Setting 

 
 

 Not exist  

Completion of loading SWX program 

 
“TVX09PB_01” is the Projectdata folder used when the SWX 
program was generated on the TPS software. 

 Yes   No  

←  Continued from previous page 

New Projectdata folder named “TVX09PB_01” is 

added. The information on the environmental setting 

and the new Parts code data is saved in the folder. 

The TPS software opens the Select Environmental 
Setting window (Fig.229). Select the holder to save. 
(See Remark 4) 
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Comparison window of Parts code data 

The Comparison window of Parts code data (Fig.235) will be displayed when the same Parts code including some 
differences (ex. Size) is found during the program loading. The items indicated by red color are different between the two 
Parts code data. The left side of Fig.235 indicates the Parts code data saved in the TPS software and the right side is the 
SWX program.  

Pressing [>] [<] key can copy the items indicated by red color to the other side. After the copy was completed, the next 
Parts code data which has difference will be displayed. Pressing [>>] [<<] key can copy the items indicated by red color in 
the whole Parts code data to the other side. 

Click the Cancel button, and the currently-displayed Parts code data window is closed without performing the copy and 
the next Parts code data which has difference will be displayed. Pressing the All Cancel button can close Fig.235. 

 
[Fig.235] Comparison window of Parts code data 
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Save 
This enables to overwrite the currently working test program. 

 

1. When there isn’t the same file name in the disk, it executes “Save As” automatically so that users 
are required to specify the file name at the time of saving the test program. 

2. When the test program is saved in SWX format for the APT-9411 Series, the Parts code data used 
in the test program will be saved at the same time. 

 
Save As 
This enables to save the currently working test program by giving it a new file name. (Refer to Fig.236) 

 
[Fig.236] Save as 

 
When the same file name already exists in the specified folder, the test program will be overwritten. 

 
Recently Used Files 
This enables to display the files opened recently. They are displayed from the newest one in order. Thus if there are often 
used files, you can load them quickly from the menu. 

 
When there is a currently working test program, save it in the disk prior to executing this operation. 

 

 
The listed number of the file is changeable at User Preference in Master mode. 

 
Convert 
This enables to load the test program made by the APT-940x/8400 Series and also save the test program made by the 
TPS software in the format for the APT-940x/8400 Series. 

Menu title Function 

Load SW9 File This is used to load the test program (.SW9/.SW91/.SW92) made by the APT-9400/9401 from the disk. 

Load SW8 File This is used to load the test program (.SW8) made by the APT-8400 (Windows version) from the disk. 

Save SW9 File This is used to save the test program in the .SW91 format for the APT-9400/9401. 

Save SW8 File This is used to save the test program in the .SW8 format for the APT-8400 (Windows version) 
 

 
When there is a currently working test program, save it in the disk prior to executing this operation. 
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Print 
This enables to output a data to the printer. 

Menu title Function 

Steps Output  Print basic data, measuring conditions and XY coordinates in the range specified by the 
step numbers. 

Pins Output  Print Pin number, XY coordinates and Net name in the range specified by pin numbers. 

Searched Step Output Print the data list which is searched based on specific condition (Parts name, Value, 
Function so on) 

 

 
Pins Output is available only when Coordinates management in Data mode is selected to “Point system”. 

 
Exit 
This enables to quit the TPS software. 

 
When there is a currently working test program, save it in the disk prior to executing this operation. 

 

Edit 

Click Edit in the Menu bar to list the Edit menu on the display. Generally the Edit menu is used when users want to edit 
the test program. If the image file is loaded, users can input and correct the XY coordinate and set the High-fly / 
No-contact-zone on the PCB image. 
 
Step Edit / Step List 
Step Edit (Fig.237) and Step List (Fig.238) are used to create, add, modify or erase the test program. 
The items (ex. Parts name, Value, Comment..) displayed on Step Edit / Step List window are user-configurable on Editor 
customize in Master mode. 

    
[Fig.237] Step Edit                                         [Fig.238] Step List 

Step Edit (Fig.237) and Step List (Fig.238) displays the board image (IMG file) taken by Real map function available as 
option for the APT-9411 Series and the contact points are indicated by orange color on the PCB image. 
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On the other hand, Fig.239 below displays the contact points without any PCB image because no board image is 
imported in the TPS software. 

 
[Fig.239] Step Edit / Step List without PCB image 

 
Pin Coordinate Edit 
This enables to open Pin Coordinate Edit menu to create or modify Pin coordinate data. When the TPS software uses 
the board image (IMG file) taken by Real map function available as option for the APT-9411 Series, double-click on the 
Pin number to modify the XY coordinates. The Tool bar displays executive icons for the Pin coordinate edit function. 

 

Pin Coordinate Edit is available only when Coordinates management in Data mode is selected to “Point 
system”. 

 
Erase Step Data 
This enables to assign the range of the step data to erase. 

 

Once the step data was erased, users cannot recover (undo) them. Be sure that they can be 
erasable prior to executing this operation. 

 
Erase Pin Coordinate 
This enables to clear the X, Y coordinates and Net name son on saved in the specified pin number. 

 

Once the pin coordinate was erased, users cannot recover (undo) them. Be sure that they can 
be erasable prior to executing this operation. 

 

 

Erase Pin Coordinate is available only when Coordinates management in Data mode is selected to 
“Point system”. 

 
Erase Searched Step 
This enables to search and erase the step data based on assigned condition. 

 

Once the step data was erased, users cannot recover (undo) them. Be sure that they can be 
erasable prior to executing this operation. 

 
Search Test Data 
This enables to search and display the step data based on assigned condition. 
 
Check for Duplicate pin’s step 
This enables to search and display the step data which use the pin numbers in common. 

 

Check for Duplicate pin’s step is available only when Coordinates management in Data mode is 
selected to “Point system”. 



- 119 - 

Menu bar on Step Edit / Step List 
This section describes executive function for the TPS software displayed on the Menu bar. In cases when the TPS 
software uses the Real map image (IMG file) taken by Real map function available as option for the APT-9411 Series, 
refer to Page 121. 

 
[Fig.240] Step Edit / Step List 

The Step Edit/List window displays the PCB image on the top and the step data list on the bottom. In addition, the Menu 
bar displayed on the top of the Step Edit/List window differs according to the cursor position currently placed by the users: 

       
(Menu bar for Step data)                 (Menu bar for PCB image) 

[Fig.241] 

 
The step data are indicated by blue color when the Parts code data has not been registered yet. 

 
Edit > Move the selected steps to A-side to B-side / Move the selected steps to B-side to A-side 
This enables to move the step data specified by Select function to other side (means, from A-side to B-side or B-side to 
A-side) together with the probing points.  
The left window in Fig.242 is displayed when A-side program is displayed and the right window is displayed when the 
B-side program is displayed. 

   
[Fig.242] Edit 
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Tool > Parts Code Property 
Clicking Part Code Property on the Tool menu can display the Property window (Fig.243) of the Part code used in the 
step where the cursor is placed on. This window enables users to modify the Parts code data. After the data modification 
was completed, the display goes back to the Step Edit / Step List window. 

 
[Fig.243] Parts Code Property 

Click the OK button after the Parts code data was modified, and it display Fig.244 below. Clicking the Yes button to have 
the TPS software run the data conversion and generate the step data. In case of clicking the No button, the Parts code 
data is saved without generating the step data. 

 
[Fig.244] 

In cases when the Parts code data is already configured, it displays Fig.245 below by clicking the OK button. Clicking the 
Yes button to have the TPS software run the data conversion at the step data which use the same Parts code and 
generate the step data again. In case of clicking the No button, the Parts code data is saved without generating the step 
data again. 

 
[Fig.245] 

 

On the Fig.245, if the Yes button is selected, the TPS software runs the data conversion at the step data 
which use the same Parts code to generate the step data again. In case when the step data have been 
modified (ex. Tolerance, Function, XY coordinates), they will be replaced by the new step data 
generated again. Therefore, if users just want to modify the Parts code data without generating the step 
data again, select the No button. 
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Menu bar when using Real map image 
Using the Real map image on the TPS software makes change and verification of the contact points easier. (Refer to XY 
Coordinate Input in Page 29) In addition, the Real map image assists users to establish the High-fly / No-contact-zone. 

 
[Fig.246] 

 
Tool 
Manually-operated coordinate set F1 
Users should place the mouse cursor on the PCB image to input the XY coordinates. (For details, refer to Page 30)  
Pressing [F1] key on the Step Edit/List window can also select the Manually-operated coordinate set function. 
 
System-aided coordinate set F2 
User can generate H-pin and L-pin with certain pitches registered in advance automatically from the XY coordinates (ex. 
Center point) included in the Takaya format data. (For details, refer to Page 32) 
Pressing [F2] key on the Step Edit/List window can also select the System-aided coordinate set function. 
 
Parts Code Property 
The same function as explained in Page 120. 
 
Window 
When the mouse cursor locates at the PCB image, the Menu bar indicates Window. To facilitate the coordinates input 
and check on the PCB image, users can take advantage of “Zoom window” and “Point(s) zoon window” so on selectable 
as option in the Window menu 

 
[Fig.247] Window 

 

Zoom window 

Point(s) zoom window 
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XY Coordinate 
When “XY Coordinate” is selected, it displays the XY coordinates value of the cross-hair point on the PCB image. 

      
[Fig.248] XY Coordinate 

 
Area window 
When “Area window” is selected, another window appears on the right side of the display to indicate the whole PCB 
image from which users can know where the cross-hair cursor is. 

 
[Fig.249] Area window 

 
Zoom window 
When “Zoom window” is selected, another window appears on the right side of the display to magnify the location on the 
PCB image where the cross-hair cursor. 

 
[Fig.250] Zoom window 

 
Point(s) zoom window 
When “Point(s) zoon window” is selected, another window appears on the right-bottom side of the display to magnify the 
XY coordinate of H-pin and L-pin. 

 
[Fig.251] Point(s) zoom window 

 

Point(s) zoom window 

XY coordinate value 
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Icon on Step Edit / Step List window 
The Step Edit / Step List window displays various icons. Some examples follow. 

  
[Fig.252] Step Edit / Step List 

 
This icon enables exchange to the PCB image and the graphic map. 

      
PCB image                                         Graphic map 

[Fig.253] 

 
This icon enables to display the top view of the PCB image and the step data.  
(Refer to Fig.252) 

 
This icon enables to display the bottom view (see through) of the PCB image and the step data.  
(Refer to the left image of Fig.254) 

 
This icon enables to display the bottom view of the PCB image and the step data.  
(Refer to the right image of Fig.254) 

      
Bottom view (see through)                    Bottom view 

[Fig.254] 

 
This icon enables to change the step data from Step List to Step Edit. 

 
This icon enables to change the step data from Step Edit to Step List. 

 

Icon 
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Reference 

Reference Value Generation 
This enables to generate Measuring conditions and Reference values automatically based on Parts name and Value of 
the step data. 
 
 

Total 

Users can accumulate the test results and output various total records to the monitor and/or the printer. 
 
Erase Total 
This enables to initialize the total records. 
 
Step Composition Ratio 
This enables to indicate the total records on the graph and the list according to category. 
 
Fail Total 
This enables to indicate type of fails (Short / Open / LOW-NG/ UP-NG etc) in order of the number of fail count. 
 
Graph 
This enables to indicate the fail occurrence status, the fail located distribution on the board, so on by a circle graph and a 
bar graph, so on. 
 
Test Coverage Report 
This assists users to diagnose the test program in details. 
 
 

Tool 

Users can accumulate the test results and output various total records to the monitor and/or the printer. 
 
Automatic guard point setting 
This enables to look into the circuit configuration based on information from Pin numbers to configure guard points 
automatically. In case that the guard point is set, be sure to input the Reference value on the APT-9411 Series. 

 

Automatic guard point setting is available only when Coordinates management in Data mode is selected 
to “Point system”. 

 
Group Separation Set 
This enables to configure groups in the test program. 
 
Group Addition 
This enables to generate the test program for a panelized board that multiple identical boards are arranged on one sheet 
automatically. For details, refer to the Operator’s guide for the APT-9411 Series. 
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Auto Location Set 
This enables to configure Location name in the program according to the set contents registered on the Fail Map window 
in Data mode automatically. 
Fig. 255 below shows the Auto Location Set window which differs depending on whether there is the Real Map image. 
When the box “Select the boarder for each location manually” is selected, users can assign border lines to separate 
locations manually. When this is not selected, it will be configured by the TPS software automatically according to both 
max and min coordinates included in the test program. 

      
(Without Real Map image)                             (With Real Map image) 

[Fig.255] Auto Location Set 
 
Change Step Data 
This assists users to change Parts name, Value, etc on a specified step data in the block. 
 
Coordinates Change for Ground 
This enables to change the ground pin of specified components to other location in the block. 
 
Real Map Adjustment 
This enables to fit the top view of the PCB image to the bottom view. Real Map Adjustment isn’t displayed in Tool menu 
unless the PCB image (.IMG / .BMP / .JPG) isn’t in the TPS software. 
 
Optimization 
This enables to optimize the test program. The Optimization function consists of followings; 
 
Coordinates Sort 
The test steps will be rearranged to minimize the distance the probes moves around to test the boards. This results in 
cutting the test time. 

Parts Name Sort 
The test steps will be rearranged in the order of the initial letter of Parts name and the parts number. 

Set Combination measurements 
The Combination measurement is set at the time of rearranging the test steps. 

Clear Combination Measurements 
The test steps in the Combination measurement will be released. 
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Coordinates 
This should be used only when the set direction and/or the Board reference point of PC boards were changed after the 
test program was generated. The Coordinates function consists of followings; 
 
Turn to Clockwise 
This enables to turn the XY coordinates of step data clockwise with 90 degrees, 180 degrees or 270 degrees. 

      
(Without Real Map image)                         (With Real Map image) 

[Fig.256] Turn to Clockwise 
Reverse Turn 
This assists users to enter the XY coordinates of THT component from the mount side. After this was done, perform this 
function so that the XY coordinates will be inverted to suit for the probing contact in the block. 

      
(Without Real Map image)                         (With Real Map image) 

[Fig.257] Reverse Turn 
Change Board Reference Point 
This enables to change the Board reference point to another point. Move the mouse cursor to the destination point and 
click the left mouse button so that it displays a red cross-hair pointer as shown in Fig.258. Then click the Execute button 
to determine the change. 

 
[Fig.258] Change Board Reference Point 

 
Change Board Reference point is not available unless the PCB image in the TPS software. 
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Mode Setting 
Users can configure the test programs, test conditions, the tester and option equipments. 
 
 
Data Mode 
Data mode enables users to configure Stamp and Bottom tools in the same manner as done in the APT-9411 Series. 

 
[Fig.259] Data mode 

 
The contest in Data mode is stored in the disk together with the test program. 

 
 
Test Mode 
Test mode enables users to configure the number of fail output and various processing flow controls in test, so on. For 
details, refer to the Operator’s guide for the APT-9411 Series. 

 
[Fig.260] Test mode 

 
The contest in Test mode is stored in the disk together with the test program. 
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Master Mode 
Master mode enables users to configure the environment of the system software and the tester, so on. 

 
[Fig.261] Master mode 

File / Folder 
This enables to specify the default folder to open the test program and to save the ATD/NGD and configure Data 
back-up function, so on.  

Main folder 
This is the folder to open the test program. When File > Open is performed, the TPS software shows the contents in this 
folder. 

External information folder 
This is the folder to save an external information file to implement “Assignment test based on external information” 
function in Test mode. 

Statistic data folder 
This is the folder to save statistic data when the box “Use Statistic function” in Data mode is selected. 

Environmental setting for convert folder 
This is the folder to save the Projectdata folders. When Convert > Load Data (TAKAYA format) File is performed, the 
TPS software shows the contents in this folder. 

 

When step data exists in the TPS software, users is prohibited from changing the Environmental setting 
for convert folder. If it has to be changed, the step data must be erased in advance. 

 

 

At the time of clicking the OK button after the Environmental setting for convert folder was changed, it 
displays Fig. 262 below. 

 
[Fig.262] 

If Yes was selected, all contents saved in the folder used before changed will be copied to the new 
folder. If No was selected, nothing will be copied. 
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Auto save 
When this box was selected, the currently working test program will be saved (backuped) automatically to the Main 
folder every certain period (1~30min) that users specified. Owing to this function, from time to time the test programs can 
be prevented from accidental blackout. 

 

For more safe, users are recommended to overwrite the currently working program periodically.  

 
Change default in Data mode 
This enables users to register setting contents in Data mode and Test mode. When a new test program is generated, 
users can reflect the registration information (default) to Data mode and Test mode. This will not only facilitate the setup 
of Data mode and Test mode but also prevents users from making a mistake in the setup operation. 

Maintain more than one environmental setting for convert 
Be sure to select the box when users want to manage more than one Projectdata folder in the TPS software. In this 
case, when Convert > Load Data (TAKAYA format) File is performed, the TPS software opens the Environmental 
setting for convert folder. 

User preferences 
This enables users to configure Time and Font used in the TPS software. 

Editor customize 
This enables users to configure the format of Step Edit and Step List. For details, refer to the Operator’s guide for the 
APT-9411 Series. 

 
 

Convert 

Users can load the Takaya format data, modify the Parts code data at the time of data conversion error and establish the 
environmental setting. 
 
Load Data (TAKAYA format) File 
This enables users to load the Takaya format data into the TPS software. For details, refer to Page 48. 
 
Environmental Setting 
This enables users to establish the environmental setting necessary for the data conversion. For details, refer to Page 55. 
 
Parts Code Database List 
This enables users to modify the Parts Code Database, especially the Parts code data. For details, refer to Page 63. 
 
Convert Error List 
This enables users to modify the Parts code data at the time of data conversion error. For details, refer to Page 68. 
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Change Parts Code Database 
This enables users to search the appropriate steps that match the specified conditions (the left column of Fig.263) and 
copy the specified contents (the right column of Fig.263) to the destination steps in the block. 

 
[Fig.263] Change Parts Code Database 

 
Associate (Parts Code Database) 
This enables users to add the Parts code data stored in other disk to the Parts Code Database in the TPS software. 
At the time of the addition, it displays a message as shown in Fig.264. 

 
[Fig.264] Associate (Parts Code Database) 

It displays Fig.265 if the same Parts code is available when the Parts code data stored in other disk is loaded in the PC. 
Concerning the Comparison window of Parts code data, refer to the explanation in Page 115. 

 
[Fig.265] Comparison window of Parts code data 

 

View 

Users can select whether the Status bar and the buttons are hidden or not. 
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Help 

About 
Users can open Fig.266 below to check the TPS software version. 

 
[Fig.266] System version information 
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